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Лабораторная работа № 1 (2 часа) 
СРАВНИТЕЛЬНЫЙ АНАЛИЗ РАСТРОВЫХ И  

ВЕКТОРНЫХ ИЗОБРАЖЕНИЙ. 
 

1. ЦЕЛЬ И ЗАДАЧИ РАБОТЫ 
Тема работы: ознакомление с двумя основными типами изображений. 
Цель работы: получить представление о векторных и растровых 

изображениях. Изучить преимущества и недостатки каждого типа. 
 

2. ОСНОВНЫЕ ТЕОРЕТИЧЕСКИЕ СВЕДЕНИЯ 
Растровые и векторные изображения, это то, что в общем виде называется 

графикой (растровой или векторной). В электронном виде и растровые, и векторные 
изображения выводятся на печать только в виде микроштрихового изображения. И 
растровые, и векторные изображения выводятся на экран монитора в виде 
растрового изображения.  

В целом можно сказать, что применительно к терминам полиграфии цифровое 
растровое изображение – это растр. Цифровое векторное изображение – это штрих. 

Следует понять, в каких случаях нужна векторная, а в каких растровая 
графика. Растровая или векторная графика это выбор пользователя в зависимости от 
стоящей перед ним задачи.  

1. Разрешающая способность изображения (разрешение). 
Для того чтобы полностью разобраться в том, что  такое разрешение, 

необходимо помнить, что растровые изображения создаются  в растровых, 
программах или оцифровываются посредством сканеров и состоят из 
прямоугольной расчетной сетки пикселей. Разрешение изображения может быть 
описано через количество пикселов на линейный дюйм изображения или его 
размеры в пикселах.  

Часто разрешающая способность растрового изображения (разрешение) 
определяется, когда изображение оцифровывается с использованием сканера или 
цифрового фотоаппарата или оно создается в программе обработки или 
редактирования изображений.  

При работе в редакторе векторной графики разрешение изображения не 
изменяется и не задается. Как уже упоминалось, качество векторного изображения 
зависит от разрешения устройства вывода, но не от разрешающей способности 
самого изображения. 

При работе в редакторе растровой  графики в большинстве программных 
средств для обработки и редактирования растровых изображений, имеется 
возможность задания количества пикселов на линейный дюйм (разрешение), 
которые составляют изображение. Следующий рисунок (рис. 1) показывает 
диалоговое окно New программы Photoshop, которое автоматически подсчитывает 
размер файла, когда изменяются значения областей ширины, высоты, разрешения 
(Width, Height, Resolution). 
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Рис. 1.1. Диалоговое окно создания нового документа. 

 
 
Пример 
Если установлено  разрешение в 72 dpi, то каждый квадратный дюйм  

изображения будет содержать более 5000 пикселов (72х72). Если задано разрешение 
300 dpi, то каждый квадратный дюйм состоит из 90 000 пикселов (300х300). 

При работе с цифровыми изображениями количество пикселов в изображении 
становится чрезвычайно важным. Размер файла в растровом изображении 
основывается на количестве пикселов в изображении. Чем больше пикселов 
содержит изображение, тем больше по размеру его файл. Даже если при наличии  
мощной графической станции, работа с большими изображениями с высоким 
разрешением может оказаться достаточно обременительной. 

Говоря о растровой графике следует указать на два ее существенных 
недостатка: 

1) значительный объем массивов данных, которые надо хранить и 
обрабатывать; 

2) невозможность масштабирования растрового изображения без потери 
качества. 

Векторная графика устраняет оба эти недостатка, но, в свою очередь, 
значительно усложняет работу по созданию художественных иллюстраций. На 
практике средства векторной графики используют не для создания художественных 
композиций, а для оформительских, чертежных и проектно-конструкторских работ. 

Для хранения информации о простейшем объекте, каковым является линия 
третьего порядка, в векторной графике необходимо всего восемь параметров. 
Добавив к ним параметры, выражающие такие свойства линии, как ее ширина, цвет, 
характер и прочие, получается, что для хранения одного объекта достаточно 20—30 
байтов оперативной памяти. Достаточно сложные композиции, насчитывающие 
тысячи объектов, расходуют лишь десятки и сотни Кбайт. 
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В векторной графике легко решаются вопросы масштабирования. Если линии 
задана толщина, равная 0,15 мм, то сколько бы ни масштабировался рисунок, эта 
линия все равно будет иметь только такую толщину, поскольку это одно из свойств 
объекта, жестко за ним закрепленное. Это свойство векторной графики широко 
используется в картографии, в конструкторских системах автоматизированного 
проектирования (САПР) и в автоматизированных системах архитектурного 
проектирования. 

При сильном увеличении растрового изображения наблюдается эффект 
пикселизации, качество изображения ухудшается и при дальнейшем увеличении 
ничего кроме квадратного растра наблюдатель не  видит. 

2. Преобразование растрового изображения в векторное. 
Раньше разработчикам, которые хотели сохранить растровый документ в 

векторном виде, приходилось вручную делать оконтуривание образов с 
последующим заполнением их заливками. 

Программа CorelTRACE 11, входящая в состав комплекта Graphics Suite 11. 
выполняет этот процесс автоматически. С ее помощью сканированные или 
рисованные растровые материалы могут быть легко преобразованы в 
редактируемые векторные документы. Формат преобразования можно выбирать в 
зависимости от того, в какой программе предполагается дальше работать с 
документом. 

Запустить CorelTRACE можно либо стандартным способом - через меню Start 
(Пуск) или щелчком на значке программы на рабочем столе, либо непосредственно 
из окна CorelDRAW. Graphics Suite 11 — это интегрированный программный 
комплекс, в котором программы обмениваются данными через механизмы OLE. 
Точно так же, как растровый рисунок командой Edit Bitmap (Редактировать 
рисунок) передается на редактирование из CorelDRAW в PHOTO-PAINT, можно 
отправить его на трассировку в CorelTRACE. Для этого нужно: 

1) В CorelDRAW выбрать растровый объект. 
2) В меню Bitmaps (Растры)  выбрать команду Trace Bitmap (Трассировать 

растр) или на панели свойств нажать кнопку Trace Bitmap.' Можно также щелкнуть 
по объекту правой кнопкой мыши и выбрать команду Trace Bitmap в контекстном 
меню. 

При запуске из CorelDRAW окно CorelTRACE открывается с загруженным 
растровым рисунком. 

Область документа в окне разбита на две части: в правой загружается 
оригинальное растровое изображение, в левой отображается результат его 
преобразования в векторный вид. 

Слева в окне, как и в других программах Graphics Suite, имеется набор 
инструментов, в котором собраны средства для выбора режима трассировки, 
изменения масштаба отображения, выбора в рисунке области для преобразования. 

Расположение по умолчанию окон оригинала и результата можно изменить. 
Например, если ширина образа значительно больше высоты, то окна выгоднее 
разместить друг под другом. Для этого нужно в меню View (Вид) выбрать команду 
Layout (Компоновка) и далее Horizontal (Горизонтально). 

Чтобы созданный векторный объект отображался не как графический образ, а 
в виде сетки сгенерированных кривых, нужно в меню выбрать команду Wireframe 
(Каркас). Если же выбрать команду Bitmap+Wireframe (Растр+Каркас), то в окне 
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результата контурная сетка будет наложена на исходный растровый образ. Эти 
режимы полезны для оценки сложности контуров и количества созданных 
векторных составляющих. 

Для некоторых методов трассировки нужно, чтобы на вход поступали 
растровые образы в определенном цветовом режиме. В частности, для режима 
Center-line (Средняя линия) и Centerline Outline (Средняя линия/Контур) требуются 
черно-белые растры. Преобразовать цветовой режим можно на месте — для этого в 
меню Image (Образ) нужно выбрать команду Mode (Режим). 

Трассировать можно не весь растровый оригинал, который может быть очень 
большим, а лишь некоторую его часть. Чтобы выбрать область трассировки, нужно 
в наборе инструментов выбрать инструмент Draw Trace Block (Выбор блока 
трассировки) и обозначить им рамку в рисунке. После этого область трассировки 
можно подстроить, перемещая инструментом Select (Выбор)  маркеры выделения 
рамки. 

Чтобы запустить операцию трассировки, нужно выбрать один из режимов в 
наборе инструментов, выбрать параметры режима в панели свойств и нажать кнопку 
Do Trace (Трассировать) или в меню Trace (Трассировка) выбрать команду запуска, 
соответствующую режиму. По окончании операции в правой части окна программы 
появится созданный векторный рисунок. 

3. Режимы трассировки. 
Outline (Контур). 
При трассировке в режиме по умолчанию Outline (Контур) выполняется 

оценка цветов и формы отдельных областей изображения, в результате чего 
создаются замкнутые объекты одного цвета. Режим выбирается кнопкой Outline. 

Созданный векторный образ может достаточно сильно отличаться от 
оригинала. Регулятором единственного параметра Accuracy (Точность) или вводом 
значения в поле качество трассировки можно существенно улучшить и при значении 
100 векторный рисунок будет похож на исходное изображение. Все сложные 
цветные текстуры, однако, заменяются заливками основных, цветов. К тому же при 
этом следует учитывать, что чем выше точность, тем больше создается 
составляющих векторных объектов, для обработки которых требуются большие 
ресурсы и мощность компьютера. Трассировка с низкими значениями параметра 
Accuracy (Точность) может быть полезной, например, для создания стилизованных 
рисунков, например, упрощенных географических карт для логотипов. 

Копированием областей текстур растрового оригинала в результирующем 
векторном рисунке можно создавать заливки узором. Векторный результат в этом 
случае будет мало отличаться от оригинала. 

Advanced Outline (Расширенный контур). 
В режиме Advanced Outline (Расширенный контур), который представляет 

собой более развитый вариант Outline, доступен большой выбор параметров 
настройки. Здесь, например, можно выбрать один из стандартных стилей 
трассировки: 

1) Accurate (Точный); 
2) Clipart (Рисунок); 
3) Photo Low Res (Фотография низкого разрешения); 
4) Photo High Res (Фотография высокого разрешения); 
5) Silhouette (Силуэт). 
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Качество результата можно также настроить установкой следующих 
параметров: 

1) Noise Filter (Фильтр шумов). Чем выше установлен уровень шумового 
фильтра, тем больше смежных пикселов разных цветов преобразуются в один цвет; 

2) Max Colors (Максимальное число цветов). Предельное количество цветов, 
которое может содержать векторный рисунок; 

3) Node Reduction (Сокращение числа узлов). Чем ниже установлен уровень 
сокращения узлов, тем ближе узлы векторного объекта соответствуют узловым 
областям или даже пикселам растра; 

4) Node Type (Тип узла). При выборе значения Cusp (Острый) в векторном 
результате сохраняются углы растра. Если выбрать тип Smooth (Гладкий), углы и 
ступени растра в векторе сглаживаются; 

5) Minimum Object Size (Минимальный размер объекта). Количество смежных 
пикселов в исходном растре, которое оценивается при обработке. Это число влияет 
на усреднение цветов в векторе. Например, при установке значения 500 средний 
цвет будет вычисляться в группах по 500 смежных пикселов. 

Все эти настройки позволяют получить хорошие результаты трассировки 
контуров. Сложные цветные текстуры, однако, здесь также заменяются простыми 
цветами. 

Подобрав удачные значения параметров, установки можно сохранить в новом 
пользовательском стиле. 

Centerline (Средняя линия). 
Режимы Centerline (Средняя линия) работают только с черно-белыми 

оригиналами и, следовательно, могут применяться для трассировки линейной 
графики и документов схемного плана (чертежи, диаграммы), контрастных 
фотографий, текста либо иных образов с четкими границами. 

В панели свойств режимов имеются настроенные стили трассировки, 
регулятор Node Reduction (Сокращение числа узлов), а также поле Iteration 
(Приближение). Этот параметр позволяет управлять степенью соответствия 
создаваемого контура сложным границам в растре. 

Режим Centerline Outline (Средняя линия/Контур) - гибрид режимов Outline и 
Centerline. Некоторого повышения качества трассировки здесь можно добиться за 
счет дополнительной регулировки параметра Accuracy (Точность). 

Следующие методы трассировки не предназначены для точного 
воспроизведения растрового образа в векторном виде. В каждом из них 
интегрирован тот или иной декоративный графический эффект. 

Режим Sketch (Эскиз) позволяет построить на основе растрового оригинала 
векторный набросок. В этом режиме изображение формируется черными тонкими 
линиями штриховки, имитирующими тон оригинала. Линии эскиза разделяются на 
группы-слои (можно создать до 32 групп), для каждой из которых устанавливается 
свой угол наклона и Порог генерации (Threshold). Густота тона цветов оригинала 
передается добавлением линий из разных слоев согласно заданному порогу: чем 
выше значение порога, тем больше пикселов со все большими значениями RGB 
могут попасть в эскиз. 

В режиме Mosaic (Мозаика) изображение создается из фрагментов, цвета 
которых усредняются на базе оценки пикселов обрабатываемой области оригинала. 
Имеется 2 варианта мозаики - обычный (плоский) и объемный. В плоской мозаике 
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фрагменты вектора могут быть квадратной, круглой или ромбической формы, а в 
трехмерной - иметь форму пирамид, кубов или призм. 

Наиболее важный параметр данного режима - количество элементов в 
векторном образе по горизонтали и вертикали. Максимальное число -200, причем 
этот параметр действует на объект трассировки - то есть на указанное число 
элементов может быть разбит как весь образ, так и только выбранная часть. Для 
небольших образов или областей трассировки режим мозаики может давать 
неплохие результаты с точки зрения сохранения текстуры цветных растров - 
например, при значении параметра 200 текстура почти полностью сохраняется. 
Однако с точки зрения дальнейшей обработки огромное количество создаваемых 
объектов (200x200=40000) делает такой образ практически бесполезным. 

В режиме Woodcut (Гравюра) генерируется векторная графика, содержащая 
линии различной толщины и под разными углами, в зависимости от интенсивности 
тона растра в данной области. В результирующем образе имитируется эффект 
гравюры по дереву. 

Для данного режима регулируются параметры Node Reduction (Сокращение 
числа узлов), Threshold (Порог), Angle (Угол линий). Нажав на панели свойств 
кнопку, можно также выбрать установки в меню Woodcut Properties (Свойства 
гравюры): 

1) Color Woodcut - цветная гравюра; 
2) Continuous cut - непрерывные линии; 
3) Tapered ends - линии с зауженными концами; 
4) Inverted - линии переменной ширины. Чем менее интенсивен тон в данной 

области растра, тем более широкие линии. 
 

 
3.  ОБОРУДОВАНИЕ И МАТЕРИАЛЬНО-ТЕХНИЧЕСКОЕ ОБЕСПЕЧЕНИЕ 

Компьютерные классы, оборудованные ПК с установленным программным 
обеспечением не ниже: 

1) Операционная система  Windows XP; 
2) Менеджер файлов Total Commander 6.03 a; 
3) Растровый графический редактор Adobe Photoshop CS. 

 
4. ЗАДАНИЕ НА ЛАБОРАТОРНУЮ РАБОТУ 

Задание на лабораторную работу выдается в электронном виде. В качестве 
задания к лабораторной работе в папке «ОВИ_Лр№01_задание» дан набор 
растровых изображений в формате png. Имя файла соответствует номеру варианта. 
Заданием на лабораторную работу является трассировка соответствующего 
изображения в векторный формат с последующим сравнением и описанием 
растровой и векторной формы.  

 
5. ПОРЯДОК ВЫПОЛНЕНИЯ РАБОТЫ 

1) Сохранить на жестком диске растровое изображение, соответствующее 
номеру варианта. 

2) Открыть изображение с помощью программы Corel Trace и преобразовать. 
3) Исходя из типа изображения выбрать режим трассировки. 
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4) Исходя из параметров изображения выполнить настройку параметров 
трассировки. 

5) Сохранить полученное изображение как «Лр№01_le.ai». 
6) Открыть растровое изображение в редакторе Adobe Photoshop. 
4) Открыть векторное изображение в редакторе Adobe Illustrator. 
5) Производя последовательные изменения (увеличение масштаба, 

уменьшение масштаба, изменение цветовой модели) двух изображений (растрового 
и векторного) сравнивать их, описывая различия самих изображений и выходных 
файлов. 

 
6. СОДЕРЖАНИЕ ОТЧЕТА 

Отчет о лабораторной работе сдается в электронном виде и должен содержать 
исходное и трассированное изображение, а также таблицу, описывающую сходства 
и различия растрового и векторного изображений в тестовом формате. 

 
7. КОНТРОЛЬНЫЕ ВОПРОСЫ 

1) Чем отличаются растровые и векторные изображения? 
2) Перечислите преимущества и недостатки растровых изображений. 
3) Перечислите преимущества и недостатки векторных изображений. 
 

8. БИБЛИОГРАФИЧЕСКИЙ СПИСОК 
1) Стефанов, С. Полиграфическое воспроизведение цветных изображений / 

С.Стефанов .— М. : Репроцентр-М, 2003 .— 32с. 
2) Залогова, Л.А. Компьютерная графика. Элективный курс : учеб.пособие / 

Л.А.Залогова .— М. : БИНОМ: Лаборатория знаний, 2005 .— 216с. 
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Лабораторная работа № 2 (4 часа) 
АНАЛИЗ ИЗОБРАЗИТЕЛЬНОГО ОРИГИНАЛА И 

ЗАПОЛНЕНИЕ ТЕХНИЧЕСКОГО ПАСПОРТА 
ИЗОБРАЗИТЕЛЬНОГО ОРИГИНАЛА. 

 
1. ЦЕЛЬ И ЗАДАЧИ РАБОТЫ 

Цель работы: ознакомление с методами анализа цифровых растровых 
полутоновых оригиналов. 

Задачи работы: произвести анализ цифрового оригинала, и заполнить 
технический паспорт полутонового оригинала. 

 
2. ОСНОВНЫЕ ТЕОРЕТИЧЕСКИЕ СВЕДЕНИЯ 

1. Общая оценка оригинала. 
На первом этапе анализа оригинала, как правило, дается общая оценка 

оригинала независимо от его типа. Предварительная оценка сводится к сортировке 
оригиналов в группы. Например, существует следующее самое распространенное, 
группирование по типам: 

1) Хороший оригинал - на оригинале нет механических повреждений; 
изображение резкое, есть детали в светах, полутонах и в тенях; тип и размер 
изображения оригинала позволяет качественно воспроизвести его в требуемом 
масштабе на оттиске. 

2) Плохой оригинал - отсутствуют или плохо проработаны детали в светах и 
тенях, недостаточный контраст изображения, недостаточная резкость, искажены 
цвета; имеются слабые повреждения, грязь и пыль. 

3) Оригинал с исправимыми дефектами (самая большая группа) - имеются 
некоторые отклонения по цвету, резкости, контрасту, но все можно исправить и 
доработать в процессе обработки изображения и подготовки к печати. 

4) Бракованный оригинал - оригинал невозможно качественно воспроизвести 
на оттиске из-за размера (не выдерживает увеличения до нужного размера без 
потери качества), формата файла (например низкое разрешение цифровой камеры), 
типа оригинала (например полиграфический оттиск).  

При оценке по критерию «тип оригинала» следует рассматривать не только 
производственный, но и технологический брак - когда оригинал не соответствует 
поставленной цели. 

Цифровой оригинал необходимо оценивать по трудоемкости и затратам 
времени на возможную доработку в программе обработки изображений. 

2. Детальная  оценка оригинала. 
На втором этапе оригиналы подвергаются более детальной оценке исходя из 

требований, которые предъявляются полиграфическими технологиями к каждому 
типу оригиналов. Так, оригиналы проверяются на соответствие техническим 
требованиям отраслевых стандартов. Однако пересмотр и разработка этих 
стандартов обычно отстает от развития технологий, поэтому собственные 
требования могут устанавливать издательства, репроцентры, дизайн-бюро, 
типографии. 

Специалисты, оценивающие цифровые оригиналы, должны в равной степени 
владеть и компьютерными, и полиграфическими технологиями. 

Общая схема оценки на втором этапе включает следующие пункты: 
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1) Геометрические параметры - соответствие размера оригинала масштабу 
воспроизведения на оттиске. 

2) Структурные характеристики - зернистость, резкость, степень проработки 
мелких деталей. 

3) Градационные характеристики - проработка деталей в светах, полутонах и 
тенях изображения. 

4) Цветовые характеристики — цветопередача, цветовой контраст, 
соответствия памятных цветов, наличие цветной вуали и воспроизведение 
нейтральных серых тонов. 

Оценка по отдельным параметрам является самой надежной и объективной, 
однако требует времени и наличия специализированного оборудования. Как 
правило, оценку по параметрам проводят выборочно — для отдельных оригиналов 
или только по отдельным параметрам. Для цифрового (электронного) оригинала 
этими параметрами являются: 

1) формат файла; 
2) цветовая модель; 
3) геометрические размеры; 
4) разрешение; 
5) значение точки белого (минимальная плотность Dmin); 
6) значение точки черного (максимальная плотность Dmax); 
7) компрессия цветовых данных; 
8) детальность проработки светов, теней, полутонов; 
9) резкость; 
10) четкость; 
11) объем информационных данных (размер файла); 
12) наличие шума и технических излишеств. 
Чтобы свести к минимуму материальные потери и избежать снижения 

качества будущей продукции, необходимо руководствоваться как требованиями 
отраслевых стандартов (например, ОСТ 29.106-90), так и конкретными 
требованиями предприятий-поставщиков (дизайн-бюро, репроцентров, типографии). 
При этом следует по возможности уменьшить или исключить использование в 
производстве нестандартных оригиналов. К нестандартным цифровым оригиналам 
относятся такие оригиналы, как графические файлы с любым видом компрессии или 
GIF, WMF и подобных графических форматов. 

3. Характерные параметры цифровых оригиналов. 
С развитием цифровых технологий, средств оцифровки, записи и хранения 

информации на компактных носителях значительно увеличилось поступление в 
производство готовых оцифрованных изображений, предлагаемых в качестве 
оригиналов. Главная проблема здесь состоит в том, что при обработке таких 
изображений оператор не видит настоящих оригиналов, и подготовка к печати 
осуществляется им только на основе собственного опыта, индивидуальных 
ощущений, уровне квалификации и зависит от требований полиграфической 
технологии. 

Цифровые оригиналы могут быть самыми разнообразными - от графических 
файлов, подготовленных для конкретного издания и выполненных на 
профессиональных сканерах, до Photo CD, изображений из Интернета и цифровых 
фото- и/или видеоустройств. В принципе, источник оцифрованного сюжета не имеет 
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существенного значения. Главное требование - соответствие требованиям 
полиграфической технологии.  

Представление оцифрованного сюжета в цветовой модели CMYK возможно 
только в случае профессиональной подготовки информации для печати с учетом 
всех требований конкретного полиграфического процесса и при наличии 
цветопробы. 

Основными графическими форматами представления данных для полиграфии 
считаются TIFF, EPS. Нежелательно использование графических файлов с 
компрессией (сжатием), например jpg. 

4. Технический паспорт полутонового  оригинала. 
Пояснения к заполнению технического паспорта полутонового оригинала  

(ОСТ 29.106-90.) 
В правом верхнем углу паспорта следует указать номер оригинала 

(оригиналов). 
1. Указать название издания. 
2. Подчеркнуть вид оригинала. 
3. Указать наличие или отсутствие дефектов. 
4. Указать результаты контроля по следующим градационным показателям: 
4.1. Результаты измерений денситометром. Для оригиналов, не содержащих 

тест-объект, измерения проводят только по рисунку и заполняют левую часть 
таблицы. Для оригиналов, содержащих этот тест-объект, измерения проводят и по 
рисунку, и по тест-объекту и заполняют левую и правую части таблицы. 

Левую часть таблицы заполняют в соответствии с п. 3.11 и 3.12 настоящего 
стандарта. 

В правой части таблицы записывают номер поля шкалы, имеющего плотность 
наиболее близкую (но не более) к Дмин оригинала и наиболее близкую (но не 
менее) к Дмакс оригинала, и измеряют их за четырьмя светофильтрами. 

4.2. Подчеркнуть полученную оценку градационного содержания оригинала. 
4.3. Указать отдельно для светов и теней оригинала пропадание деталей 

изображения. 
5. Указать результаты контроля по пунктам: 
5.1. Процентный показатель и цвет коррекционного светофильтра, 

соответствующего отклонению многоцветного диапозитива от нейтральности. 
5.2. Процентный показатель и цвет коррекционного светофильтра, 

компенсирующего цветную вуаль. 
6. Указать (для глянцевых фотоотпечатков) "равномерный" или 

"неравномерный". 
7. Указать "заметна" или "незаметна". 
8. Указать "гладкая" или "рельеф". 
9. Указать толщину оригиналов. 
10. Указать формат оригинала. 
11. Указать "соответствуют" или "не соответствуют" размеры полей оригинала 

требованиям настоящего стандарта. 
12. Указать зону размытого перехода оригинала (в мкм). 
13. Указать "заметно" или "незаметно". 
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14. Указать допустимое увеличение изображения оригинала при 
репродуцировании с учетом его резкости, зернистости и допусков настоящего 
стандарта по этим параметрам (в %). 

15. Указать "соответствует" или "не соответствует" оригинал ОСТу. В 
последнем случае следует указать, по каким позициям настоящего паспорта 
оригинал не соответствует ОСТу. 

16. Указать особенности оригинала по сравнению с показателями ТУ 
("пурпурная вуаль", "зеленое освещение лиц", "зернистость", "нерезкость" и т.д.); 
дать указания по репродуцированию оригинала ("убрать пурпурную вуаль", 
"сохранить зеленое освещение лиц"). 

Если оригинал подлежит согласованию с типографией, то подпись 
представителя типографии должна быть поставлена под подписью представителя 
издательства. 

*Примечание. Пункт 5 заполняется только для многоцветных диапозитивов. 
 

3.  ОБОРУДОВАНИЕ И МАТЕРИАЛЬНО-ТЕХНИЧЕСКОЕ ОБЕСПЕЧЕНИЕ 
Компьютерные классы, оборудованные ПК с установленным программным 

обеспечением не ниже: 
1) Операционная система  Windows XP; 
2) Менеджер файлов Total Commander 6.03 a; 
3) Растровый графический редактор Adobe Photoshop CS. 

 
4. ЗАДАНИЕ НА ЛАБОРАТОРНУЮ РАБОТУ 

Задание на лабораторную работу выдается в электронном виде. В качестве 
задания к лабораторной работе в папке «ТОИИ_Лр№02_задание» дан набор 
растровых изображений в формате jpg. Имя файла соответствует номеру варианта. 
Заданием на лабораторную работу является анализ изображения и заполнение 
технического паспорта изобразительного оригинала исходя из параметров, 
соответствующих варианту задания.  

 
Варианты заданий для выполнения лабораторной работы 

Номер варианта Размер оттиска, см 
1 12х8 
2 15х11,25 
3 20х26 
4 10х7,5 
5 20х15 
6 15х20 
7 20х12,5 
8 10х7,5 
9 25х17,4 
10 25х18,75 
11 40х27 
12 30х19,7 
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5. ПОРЯДОК ВЫПОЛНЕНИЯ РАБОТЫ 
1) Сохранить оригинал на жестком диске, и открыть его с помощью 

программы Adobe Photoshop.  
2) Открыть технический паспорт изобразительного оригинала с помощью 

программы MS Word. 
3) В пункте 1 указать номер группы,  фамилию  и инициалы. 
4) Дать общую оценку оригинала. Обосновать свое заключение и заполнить 

п.2 и 3 технического паспорта. 
5) Денситометрические показания снимать с помощью меню 

Image>Adjustment>Levels (Изображение> Коррекция >Уровни). Следует помнить, 
что в данном случае измерительный инструмент Eydropper (Пипетка) измеряет не 
оптическую плотность D , а яркость L . Применительно к стандартному цифровому 
изображению с 256 порогами яркости, оптическая плотность рассчитывается, как: 

)256lg( LD  .                                                (1) 
6) Сняв денситометрические показания, заполнить п.4.1 технического 

паспорта. 
7) Оценив распределение светов, теней с средних тонов с помощью меню 

гистограммы Image>Adjustment>Levels (Изображение> Коррекция >Уровни) 
заполнить п.4.2 технического паспорта. 

8) Оценив визуально изображение, заполнить п.4.3 технического паспорта  
9) Пункт 6,8, 9 и 11 для цифровых оригиналов  не заполняется. Остальные 

пункты заполнить, исходя из визуальной оценки оригинала. 
10) Заполнить п.10 технического паспорта, определив размеры оотиска для 

рассматриваемого оригинала. Размер оттиска определяется с помощью меню 
Image>Image size (Изображение>Размер изображения) для разрешения 300 dpi. 

11) Контроль резкости в пункте 12 следует проводить визуально просмотром 
оригинала с увеличением, кратность которого соответствует масштабу 
воспроизведения. Следует измерить зону размытого перехода на оригинале (ширину 
границы резкой детали, расположенной на фоне). Границы зоны размытого 
перехода определяются визуально: начало и конец зоны отсчитываются от точек, 
где начинается и кончается визуально заметное изменение плотности. Допустимую 
зону размытого перехода следует определять по формуле: 

mL /104 ,                                                     (2) 
где L  — допустимая зона размытого перехода для данного оригинала, мкм; m  

— масштаб репродуцирования, %. 
Для изображений, которые рассматривают на расстоянии более 1 метра 

(плакаты и т.п.), допустимую зону размытого перехода рассчитывают по формуле: 
mSL /3,33 ,                                                 (3) 

где S  — расстояние рассматривания репродукции, мм. 
При определении зоны размытого перехода для оригиналов с произведений 

искусства в формулу (2) или (3) следует ввести поправочный коэффициент 0,5. 
12)  П. 14 технического паспорта заполняется с помощью меню Image>Image 

size (Изображение>Размер изображения), исходя из того, что качественный оттиск 
должен иметь минимально  разрешение 300 dpi. Следует определить максимальные 
размеры оттиска, который может быть получен на основе данного оригинала, 
исходя из условия постоянства пиксельного размера. 
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13) В п. 16 технического паспорта указать перечень дефектов и недостатков 
оригинала  (если они есть). 

14) Сохранить заполненный технический паспорт оригинала, как 
«Лр№02_le.doc». 

 
6. СОДЕРЖАНИЕ ОТЧЕТА 

Отчет о лабораторной работе сдается в электронном виде и должен содержать 
исходное изображение и заполненный технический паспорт оригинала. 

 
7. КОНТРОЛЬНЫЕ ВОПРОСЫ 

1)Какие дефекты оригиналов относятся к разряду исправимых? 
2) Какие форматы файлов относятся к стандартными цифровым оригиналам? 
3) Каким образом осуществляется контроль резкости оригинала? 
4) Каким образом осуществляется оценка градационных характеристик 

оригинала? 
 

8. БИБЛИОГРАФИЧЕСКИЙ СПИСОК 
1) Стефанов, С. Изображения: градация и цвет / С.Стефанов .— М. : 

Репроцентр М, 2005 .— 48с. 
2) Стефанов, С. Полиграфическое воспроизведение цветных изображений / 

С.Стефанов .— М. : Репроцентр-М, 2003 .— 32с. 
3) Стефанов, С. Оценка печати оттисков / С.Стефанов;под ред.Ю.Стефановой 

.— М. : Репроцентр-М, 2003 .— 38с.  
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Лабораторная работа № 3 (3 часа) 
ОСНОВНЫЕ МЕТОДЫ ТОЧНОЙ КОРРЕКЦИИ  

ГРАДАЦИОННОГО И ЦВЕТОВОГО  СОДЕРЖАНИЯ  
ИЗОБРАЖЕНИЯ. 

 
1. ЦЕЛЬ И ЗАДАЧИ РАБОТЫ 

Цель работы: ознакомление с основными методами коррекции изображений. 
Задачи работы: выполнить тоновую коррекцию изображения с помощью 

регулировки уровней яркости и контрастности, и наложения корректирующих 
слоев. Выполнить цветовую коррекцию изображения с помощью регулировки 
цветового баланса, наложения корректирующих слоев и использования каналов. 

 
2. ОСНОВНЫЕ ТЕОРЕТИЧЕСКИЕ СВЕДЕНИЯ 

Графический редактор Adobe Photoshop обладает широким спектром 
возможностей коррекции тонового и градационного содержания изображений. 
Перечислим основные из них. 

1. Тоновая коррекция изображения. 
1.1. Команда Brightness/Contrast(Яркость/Контраст). 
Команда Brightness/Contrast(Яркость/Контраст) меню Image>Adjust 

(Изображение/Коррекция) является самым простым способом тоновой коррекции 
всего изображения. Однако простота этой коррекции связана серьезными 
ограничениями, поскольку не позволяет осуществлять изменение яркости и 
контраста на выбранных тоновых диапазонах и отдельных цветовых каналах, как 
это позволяют делать команды Curves(Кривые) и  Levels(Уровни).  

В диалоговом окне Brightness/Contrast (Яркость/Контраст) есть всего две 
полосы, в которых перемещением движков изменяют яркость и контрастность в 
диапазоне от -100 до +100 (Рис.1.1) Формально значения яркости и контраста не 
зависят друг от друга, вместе с тем следует иметь в виду, что изменение одного из 
параметров влечет за собой изменение и другого. Увеличение или уменьшение 
яркости ведет к уменьшению контраста, увеличение контраста способствует 
увеличению яркости, а уменьшение контраста - уменьшению яркости изображения.  

 

 
Рис.3.1. Диалоговое окно Brightness>Contrast(Яркость>Контраст). 

 
При увеличении яркости сбалансированного изображения происходит сдвиг 

тонового диапазона в сторону светов, то есть осуществляется отсечение черного 



 18

цвета и темных тонов, а следовательно место черного (черной точки) занимает один 
из темно-серых оттенков. При уменьшении яркости происходит сдвиг тонового 
диапазона в сторону теней, то есть осуществляется отсечение белого цвета и 
светлых тонов, а следовательно место белого (белой точки) занимает один из 
светло-серых оттенков. При увеличении контраста происходит сдвиг тонового 
диапазона к краям, то есть к черному и белому цветам, следовательно, количество 
белого и светлых тонов увеличится - изображение становится ярче. При 
уменьшении контраста происходит сдвиг тонового диапазона к центру, то есть 
количество черного и темных тонов увеличится - изображение становится темнее. 

1.2. Команда Levels (Уровни). 
В диалоговом окне Levels (Уровни) представлена гистограмма распределения 

пикселей по градациям яркости - такая же, как в окне Histogram (Гистограмма).  
Следует установить флажок Preview (Просмотр), чтобы результат коррекции 

был виден сразу, без закрытия окна.  
 

 
Рис. 3.2. Диалоговое окно Levels(Уровни). 

 
По нижней оси гистограммы расположены три ползунка, отмечающие 

положение черного, белого и средне-серого цветов изображения. После их 
перемещения, то есть после определения подсветки и тени на изображении, нужно 
откорректировать гамму, то есть уровень средних тонов. Смещение серого ползунка 
сдвинет точку нейтрального серого цвета в изображении.  

Устанавливаемые значения тонов называются входными уровнями. Их можно 
задавать численно в полях Input Levels (Входные значения). При интерактивной 
настройке числа в этих полях соответственно меняются.  

Пипетки с различными наполнителями (чёрный, белый, и серый) служат для 
определения участков, которые будут определены как самые тёмная, светлая и серая 
точки изображения соответственно. Например, при щелчке черной пипеткой по 
тому цвету на изображении, который субъективно видится самым темным, все 
оттенки темнее указанного будут отсечены (пропадут).  

Коррекция уровней позволяет изменять основные тоновые характеристики, 
настраивать диапазон тонов и менять положение нейтральной точки, то есть гамму 
изображения. В окне Levels (Уровни) удобно выполнять простейшие операции по 
коррекции контраста и яркости изображения, как в средних тонах (с помощью 
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изменения гаммы), так и в общем (регулируя выходные уровни). Управляя 
выходными уровнями, можно регулировать наиболее яркий и темный тона 
изображения, предназначенного для печати.  

Использовать подобную коррекцию и, тем более, настраивать ее параметры 
имеет смысл прежде всего при обработке нескольких изображений, нуждающихся в 
одинаковой коррекции уровней. Для проведения серийной настройки очень удобно 
сохранить все настройки окна в файл командой Save (Сохранить). Впоследствии 
созданный файл с настройками активизируется командой Load (Загрузить).  

1.3. Команда Curves (Кривые). 
Интересным инструментом тоновой коррекция является команда Curves 

(Кривые), расположенная в меню Image>Adjust (Изображение>Коррекция). С 
помощью диалогового окна Curves (Кривые) можно осуществлять любую тоновую 
коррекцию, описанную выше. Однако оригиналы изображений могут иметь самые 
изощренные погрешности. Тоновые кривые дают возможность исправить даже 
очень сложные дефекты оригинала.  

 
Рис.  3.3. Диалоговое окно Curves (Кривые). 

 
Основную часть окна занимает график распределения пикселов. В отличие от 

гистограммы, представляющей абсолютные значения распределения, график кривых 
строится как относительный. По оси Х расположены градации яркости на входе 
(Input (Входные)), то есть текущие яркости пикселов, а по оси Y - значения на 
выходе (Output (Выходные)), то есть результат коррекции. Состояние тонов при 
открытии окна изображается как линия под углом 45°, то есть отсутствие 
коррекции. Установленный режим условно обозначается тоновой растяжкой в 
полоске под графиком. В центре полоски располагается переключатель режимов в 
виде двойной стрелки. Щелчок на ней меняет направление растяжек -  правый 
верхний угол будет соответствовать меньшим яркостям, а левый нижний - большим. 
Такой режим отсчета яркостей обычно используется для изображений в модели 
CMYK.  
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Перетаскивание нижней точки кривой вправо  отсекает наиболее темные 
входные уровни, растягивая диапазон тонов в сторону теней. Перетаскивание 
верхней точки кривой влево растянет диапазон в сторону цветов. Увеличение 
наклона кривой повышает контраст. Уменьшение наклона, соответственно, снижает 
контраст. Перемещение крайних точек  вдоль вертикальных осей отсекает краевые 
выходные уровни. Положение средней точки кривой соответствует средним тонам. 
Если она не смещена относительно центра, яркость изображения не меняется.  

Основная тонкость работы со средними участками кривой заключается в 
следующем. При открытом диалоговом окне Curves поместим курсор в виде 
пипетки на тот участок изображения, который нуждается в индивидуальном 
подходе, затем нажмем левую кнопку мыши. На кривой в окне появится точка, 
соответствующая выбранному месту по тону. Чтобы эта точка появилась на кривой,  
щёлкнем на выбранном участке, удерживая клавишу Ctrl. На кривой появится 
чёрная точка, которую можно перемещать и тем самым регулировать тон в той 
части диапазона, которая содержит оттенки редактируемого участка изображения. 
Если возникла необходимость удаления точки, то удалить её можно щелчком мыши 
с удержанием клавиши Ctrl.  

Тоновая кривая должна неизбежно быть кривой, она  не может быть 
ступенчатой, потому что ступеньки на кривой повлекут выпадение полутонов и 
плохое качество картинки. Режим создания кривой вручную позволяет нарисовать 
кривую от руки.  

2. Цветовая коррекция изображения. 
Специфика работы с цветом заключается в том, что влияние, оказываемое на 

отдельный цветовой компонент, например только на красную составляющую, 
обязательно отразится и на других. Поэтому следует иметь в виду, что в основе 
любой цветовой коррекции лежит настройка не отдельных цветов, а настройка 
баланса цветов.  

Из принципа баланса проистекает дополнительная трудность: многообразие 
способов достижения одного и того же результата. 

2.1. Команда Color Balance (Цветовой баланс). 
Диалоговое окно этой команды позволяет изменить цветовой баланс во всем 

изображении, для избирательного управления цветом следует пользоваться другими 
командами, например Hue/Saturation (Цветовой тон/Насыщенность), Replace Color 
(Заменить цвет) или Selective Color (Выборочная коррекция цвета).  

 

 
Рис. 3.4. Диалоговое окно Color Balance. 
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Цветовой баланс устанавливается раздельно для светов (переключатель 

Highlights), средних тонов (переключатель Midtones) и теней (переключатель 
Shadows).  

При работе с изображениями в цветовой модели RGB полезно устанавливать 
флажок Preserve Luminosity (Сохранить яркость тонов), который препятствует 
изменению диапазона яркостей при изменении цветового баланса, что позволяет 
сохранить исходный тоновый диапазон изображения.  

Поле Color Levels (Уровни) и три шкалы с бегунками позволяют добавлять и 
убавлять цвета, названия которых вынесены на края полос.  Для добавления цвета 
бегунок перемещают в сторону этого цвета, а для убавления - в противоположную 
от него сторону.  

 
В соответствии с перемещением движков в цифровых полях над полосами 

отображаются величины изменения цвета для красного, зеленого и синего каналов в 
диапазоне от -100 до +100. 

2.2. Команда Hue/Saturation (Цветовой тон/Насыщенность). 
Команда Hue/Saturation (Цветовой тон/Насыщенность) служит для 

настройки цветового тона, насыщенности и яркости любой цветовой составляющей 
изображения на основе цветового круга. 

 В списке Edit (Цвета) диалогового окна Hue/Saturation (Цветовой 
тон/Насыщенность) представлены шесть вариантов цветовых диапазонов 
аддитивной (RGB) и субтрактивной (CMYK) моделей в порядке цветового круга 
Reds (Красные), Yellows (Желтые), Greens (Зеленые), Cyans (Голубые), Blues 
(Синие), Magentas (Пурпурные) и полный диапазон Master (Все). 

 

 
Рис. 3.5. Диалоговое окно Hue/Saturation. 

 
Шкала Hue (Цветовой тон) служит для установки нужного цвета с помощью 

движка или ввода значения в цифровое поле (в градусах цветового круга от -180 до 
+180). В нулевом положении отображается текущий цвет, от него и осуществляется 
отсчет, положительные значения обозначают вращение по цветовому кругу по 
часовой стрелке, а отрицательные - против часовой стрелки.  

Шкала Saturation (Насыщенность) используется для увеличения 
насыщенности, если перемещать бегунок вправо от нулевой точки, или для ее 
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уменьшения, если перемещать бегунок влево. Перемещение движка в зависимости 
от текущего цвета идентично перемещению цвета от центра или к центру цветового 
круга (диапазон изменения  от -100 до +100).  

Шкала Lightness (Яркость) используется для увеличения яркости, если 
перемещать бегунок вправо от нулевой точки, или для ее уменьшения, если 
перемещать бегунок влево (диапазон изменения  от -100 до +100).  

В нижней части диалогового окна расположены две цветовые спектральные 
полосы: верхняя отображает спектр до настройки, а нижняя - после. При выборе 
одного из цветовых диапазонов между полосами появляются движки настройки 
диапазона.  

Флажок Colorize (Тонирование) используется для монохромного тонирования 
изображения. При установке он указывает нулевое значение цвета на цветовом 
круге (красный цвет). При перемещении движка в полосе Hue (Цветовой тон) в 
нижней шкале отображается любой цвет из цветового круга. Изображение 
отображается в градациях этого цвета.  

Данный способ можно широко применять для цветного тонирования черно-
белых фотографий (если они сканированы в режиме градаций серого, их 
необходимо конвертировать в цветовую модель RGB). 

2.3. Палитра Channels (Каналы). 
На самом деле описанные выше команды, помимо коррекции яркости и 

контраста, позволяют выправить и серьезные искажения цвета, если таковые 
имеются. Для этого надо корректировать не общее изображение, а отдельные 
цветовые каналы. 

Каждый канал выглядит как черно-белое изображение с полутонами, которое 
вполне можно как таковое и обрабатывать. Выбирая по очереди строки Red, Green и 
Blue (для модели RGB) или Cyan, Magenta, Yellow, Black (для модели CMYK)  в 
палитре Channels (Каналы)и обрабатывая их так, как  обычную черно-белую 
фотографию - добиваясь в каждой из них максимальной проработки деталей - как в 
светлых, так и в темных частях изображения,  можно пользоваться любой из команд 
корректировки яркости-контраста - Brightness/Contrast, Levels или Curves. 

Узнать, как действия повлияли на общий цвет изображения, можно только по 
окончании каждого из этапов работы - щелкнув по строке RGB.  
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Рис. 3.6. Палитра каналов. 

 
После коррекции всех трех каналов, просмотрев общее изображение, 

поправив в нем черную и белую точки, остается только подобрать положение серой 
точки. Если цветопередача остается не совсем правильной, можное еще раз 
подстроить каналы, вновь выбирая их по одному, но подключив и канал RGB 
(щелчком по глазку), чтобы видеть изображение в целом - на этапе точной подгонки 
цвета так будет правильнее. 

Конечно, не всякое изображение можно откорректировать таким способом. 
Иногда приходится применять и прямую коррекцию цветов. Или же в разных частях 
изображения придется применять разную коррекцию (если цветовые сдвиги не 
удается привести к общему знаменателю). 

2.4. Adjustment Layers (Корректирующие слои). 
Корректирующие слои повторяют команды из меню Image>Adjust 

(Изображение>Коррекция), поэтому,  и называются Adjustment Layers. Смысл 
корректирующего слоя в том, что он изменяет цветовые/яркостные характеристики 
всех слоев, лежащих ниже него, при этом информация, содержавшаяся в этих слоях, 
остается неизмененной. То есть, всегда можно вернуться к изначальному варианту, 
просто удалив или отключив корректирующий слой, или изменить параметры слоя, 
если коррекция получилась неудачной.  

При создании корректирующего слоя открывается диалоговое окно, 
соответствующее его параметрам, то есть тому, что он корректирует – Кривые, 
Уровни, и тому подобное. Это же окно откроется после двойного щелчка по иконке 
слоя.  

Если нужно, чтобы корректирующий слой оказывал влияние только на 
определенные слои, для него можно создать маску нужной формы, или просто 
скопировать ее со слоя, который корректируется. На слои, лежащие выше, действие 
корректирующего слоя не распространяется.  
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Корректирующие слои – простой в обращении, удобный и мощный, хотя и 
ресурсоемкий инструмент.  

 
3.  ОБОРУДОВАНИЕ И МАТЕРИАЛЬНО-ТЕХНИЧЕСКОЕ ОБЕСПЕЧЕНИЕ 

Компьютерные классы, оборудованные ПК с установленным программным 
обеспечением не ниже: 

1) Операционная система  Windows XP; 
2) Менеджер файлов Total Commander 6.03 a; 
3) Растровый графический редактор Adobe Photoshop CS. 

 
4. ЗАДАНИЕ НА ЛАБОРАТОРНУЮ РАБОТУ 

Задание на лабораторную работу выдается в электронном виде. В качестве 
задания к лабораторной работе в папке «ТОИИ_Лр№01_задание» дан набор 
растровых изображений в формате jpg. Имя файла соответствует номеру варианта. 
Заданием на лабораторную работу является выполнение объективной и 
субъективной коррекции соответствующего изображения, описание всех этапов и 
параметров, а так же обоснование выбора параметров коррекции. 

  
5. ПОРЯДОК ВЫПОЛНЕНИЯ РАБОТЫ 

1) Сохранить на жестком диске растровое изображение, соответствующее 
номеру варианта и открыть его с помощью программы Adobe Photoshop. 

2) С помощью меню Image>Adjustment>Levels (Изображение> Коррекция 
>Уровни) оценить гистограмму распределения входных уровней яркости 
изображения. 

3) Оценить положение и яркость белой и черной точки. 
4) Проверить гистограмму на наличие «провалов». 
5) С помощью меню Image>Adjustment>Levels (Изображение> Коррекция 

>Уровни) скорректировать найденные дефекты изображения. 
6) Выявить максимально информативный участок изображения и оценить его 

тоновую составляющую. 
7)  С помощью меню Image>Adjust > Curves 

(Изображение>Коррекция>Кривые) изменить соответствующий яркостный 
диапазон для лучшего проявления деталей. 

8) Оценить цветовой баланс изображения и выявить его сдвиги. 
9) С помощью меню Image>Adjust>Color Balance 

(Изображение>Коррекция>Цветовой баланс)  или Image>Adjust> Hue/Saturation 
(Изображение>Коррекция>Цветовой тон/Насыщенность) откорректировать 
цветовой баланс изображения.  

10) С помощью палитры Channels (Каналы) выявить тот цветовой канал, в 
котором информационное содержание максимально. 

11) С помощью меню Image>Adjust > Curves 
(Изображение>Коррекция>Кривые) изменить соответствующий яркостный 
диапазон выбранного канала для лучшего проявления деталей. 

12) Вместо указанных команд меню допустимо применять аналогичные 
корректирующие слои. 

13) Сохранить результат, как «Лр№03_le.tif» 
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6. СОДЕРЖАНИЕ ОТЧЕТА 
Отчет о лабораторной работе сдается в электронном виде и должен содержать 

исходное и скорректированное изображение. 
 

7. КОНТРОЛЬНЫЕ ВОПРОСЫ 
1)Какие методы точной тоновой коррекции вы можете назвать?  
2) Какие методы упрощенной тоновой коррекции вы можете назвать? 
3) В чем преимущество корректирования отдельных каналов? 
4) В чем преимущество использования корректирующих слоев? 
 

8. БИБЛИОГРАФИЧЕСКИЙ СПИСОК 
1) Стефанов, С. Изображения: градация и цвет / С.Стефанов .— М. : 

Репроцентр М, 2005 .— 48с. 
2) Стефанов, С. Полиграфическое воспроизведение цветных изображений / 

С.Стефанов .— М. : Репроцентр-М, 2003 .— 32с. 
3) Стефанов, С. Цветное изображение на оригинале, мониторе компьютера и 

на полиграфическом оттиске / С.Стефанов;под ред.Ю.Стефановой .— М. : 
Репроцентр-М, 2003 .— 64с. 
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Лабораторная работа № 4 (4 часа) 
ТРЕППИНГ И РАСЧЕТ ПАРАМЕТРОВ ВЫВОДА ПОЛНОЦВЕТНОГО 

ЦВЕТОДЕЛЕННОГО ИЗОБРАЖЕНИЯ. 
 

1. ЦЕЛЬ И ЗАДАЧИ РАБОТЫ 
Цель работы: ознакомление с основными методами треппинга 

цветоделенных изображений. 
Задачи работы: произвести учет несовмещения красок при печати и треппинг 

цветного штрихового изображения.  
 

2. ОСНОВНЫЕ ТЕОРЕТИЧЕСКИЕ СВЕДЕНИЯ 
1. Неприводка и основные ее причины. 
Неприводка - сдвиг изображений, выполненных различными печатными 

красками на оттиске при синтезе многокрасочного изображения. Происходит 
вследствие некачественного выполнения приводки, приладки печатных форм или 
изготовления самих цветоделенных фотоформ, а также деформации фотоформ, 
офсетных печатных форм, дефектов монтажа, неточности подачи и/или передачи 
листов бумаги, деформации бумаги при изменении ее влажности в процессе 
печатания и др. причин. 

Любая полиграфическая печатная машина — даже самая современная и 
оптимально настроенная — не может совместить составляющие цвета CMYK с 
абсолютной точностью. Без учета неприводки оттиск может выглядеть так, как 
показано на рисунке. 

 

 
Рис.4.1. Результат неприводки. 

 
Если объекты, которые накладываются друг на друга, имеют общие цвета, то 

для таких объектов треппинг, скорее всего, не потребуется. Например, если первый 
объект содержит 30% пурпурного и 90% желтого (светло-охристый цвет), а второй 
объект — 60% пурпурного и 20% черного (фиолетовый цвет), то между ними 
незапечатанного пространства появиться не может, на худой конец может оказаться 
пурпурный зазор, поскольку пурпурная краска является общей для обоих объектов. 

Если цвета соседних объектов совсем разные, необходим треппинг, который 
бывает двух типов: 

1) Внешний треппинг (spread), который расширяет границы светлого объекта 
на темном фоне для обеспечения небольшого перекрытия. 

2) Внутренний треппинг (choke), который перемещает границы светлого фона 
внутрь тёмного объекта для создания небольшого перекрытия. 
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2. Установка треппинга. 
При цветоделении объекты, которые частично перекрывают друг друга, могут 

распределяться на цветоделенные полосы следующими способами.  
1) Цвет верхнего объекта надпечатывается (overprint) в области перекрытия 

на цвет нижнего объекта без удаления последнего (см. предыдущий раздел). 
2) Цвет нижнего объекта в области перекрытия может удаляться (knockout).  
Первый вариант свойственен только для печати плашечными цветами, когда 

каждый цвет печатается специальной смесовой краской. А второй вариант 
характерен для печати триадными красками, которые, будучи нанесенными 
мелкими точками, при физическом и оптическом наложении образуют 
многообразие цвета. 

Для цветной плашечной печати большое значение имеет точность наложения 
оттисков различного цвета в отведенных границах. У соприкасающихся объектов 
разного цвета неверная приводка создает пустые незапечатанные пробелы, с одной 
стороны, и необоснованные "нахлесты" - с другой. 

В практике полиграфических процессов можно значительно уменьшить 
возможность неверной приводки, но свести ее к нулю нереально, поэтому 
разработана технология треппинга (trapping) - небольшое увеличение или 
уменьшение площади объекта, с тем, чтобы компенсировать сдвиг во время печати 
печатных форм относительно друг друга. В программе Adobe Illustrator 
используются следующие методы создания треппинга. 

При помощи команды Trap (Треппинг) меню палитры Pathfinder (Обработка 
контуров) выполняется автоматический треппинг для изображения, состоящего из 
простых объектов. Этот метод не предназначен для таких сложных объектов, как 
градиентные и декоративные заливки, импортированная точечная графика.  

Функция команды Trap (Треппинг) состоит в том, что программа находит в 
изображении светлые объекты, независимо от их расположения (в качестве 
изображения или фона) и применяет к ним установленные параметры треппинга. 

Если два перекрывающихся объекта оказываются светлого цвета, программа 
использует малейшее отличие в цвете, чтобы отдать предпочтение одному из 
объектов. Если "решение" программы не кажется пользователю 
удовлетворительным, то с помощью флажка Reverse Traps (Инверсный треппинг) в 
диалоговом окне Pathfinder > Trap (Обработка контуров > Треппинг) можно 
изменить направление треппинга. 

Для выполнения треппинга необходимо выделить два или более объектов и 
выполнить команду Trap (Треппинг), программа выводит на экран диалоговое окно 
Pathfinder > Trap (Обработка контуров > Треппинг)). 

 
Рис. 4.2. Диалоговое окно Pathfinder Trap 
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В поле Thickness (Толщина) задается величина треппинга в диапазоне от 0,01 
до 5000 пунктов. Значение это обязательно необходимо согласовывать со 
специалистами типографии. 

 Поля Height (Высота) и Width (Ширина) служат для определения 
соотношения треппинга по вертикали и по горизонтали. Установка этих значений 
может быть вызвана необходимостью компенсировать, например, неравномерное 
растяжение бумаги по горизонтали и по вертикали в процессе печати. Значение по 
умолчанию 100% предполагает одинаковую величину треппинга в обоих 
направлениях, для того чтобы увеличить треппинг по горизонтали, следует 
установить значение больше 100% (но не более 400%), а чтобы уменьшить — 
значение меньше 100% (но не меньше 25%). 

 В поле Tint Reduction (Осветление) можно установить значение, которое 
обеспечит изменение цветового оттенка области треппинга, применяемого к 
светлому объекту. По умолчанию принимается значение 40%. 

 Флажок Traps with Process Color (Треппинг составными цветами) 
обеспечивает конвертирование оттенка цвета в области треппинга в эквивалент 
триадного цвета (в параметрах цветовой модели CMYK). Это должно 
способствовать предотвращению появления другого плашечного цвета при 
цветоделении. 

 Флажок Reverse Traps (Инверсный треппинг) обеспечивает изменение 
направления треппинга (не у более светлого, а у более темного). Эта функция не 
распространяется на объекты с так называемым "насыщенным черным" (Rich Black) 
- цвет, содержащий, помимо черного, какое-либо количество голубого, пурпурного 
или желтого цветов. 

 Кнопка Defaults (По умолчанию) позволяет восстановить значения, принятые 
по умолчанию. 

2.1. Треппинг наложением. 
Если требуется более точное управление треппингом, чем это позволяет 

кнопка Trap (Треппинг), или треппинг сложных объектов, то можно выполнить 
треппинг, изменяя параметры обводки объектов. 

Для этого необходимо выделить верхний объект из тех, которые должны 
"участвовать" в треппинге, а затем с помощью команды Stroke (Обводка) меню 
Window(Окно) вызвать на экран палитру Stroke (Обводка), с помощью которой 
можно смоделировать треппинг. 

- Для того чтобы создать внешний треппинг (spread), необходимо присвоить 
обводке те же параметры цвета, что и у заливки объекта, а также увеличить толщину 
обводки. 

- Для того чтобы создать внутренний треппинг (choke), необходимо присвоить 
обводке те же параметры цвета, которые имеет фоновый объект, в этом случае у 
объекта цветовые параметры обводки и заливки будут различными. 

В поле Weight (Толщина) следует установить значение толщины обводки в 
диапазоне от 0,6 до 2,0 пунктов, учитывая, что обводка толщиной 1 пункт создает 
величину треппинга в половину этого значения. Точное значение треппинга 
обязательно необходимо согласовать со специалистами типографии. 

Затем следует активизировать палитру Attributes (Атрибуты) и установить 
флажок Overprint Stroke (Наложение обводки), что обеспечит во внешнем и 
внутреннем треппингах печать с наложением в указанных областях. 
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Для того чтобы создать треппинг у обводки, необходимо выделить 
соответствующий объект, затем в палитре Stroke (Обводка) присвоить обводке 
белый цвет и установить необходимую толщину. С помощью команды Сору 
(Скопировать) меню Edit (Правка) необходимо скопировать контур в буфер обмена, 
а затем выполнить команду Paste in Front (Вклеить вперед) меню Edit (Правка). 
Копия контура будет помещена поверх оригинала и выделена. 

С помощью палитры Stroke (Обводка) следует присвоить необходимые цвет и 
толщину, причем толщина должна быть больше прежней на величину треппинга. 
Затем следует активизировать палитру Attributes (Атрибуты) и установить флажок 
Overprint Stroke (Наложение обводки). 

Для того чтобы выполнить треппинг не у всего объекта, а только у его части, 
необходимо поступить следующим образом: создать новый контур вдоль линии 
предполагаемого треппинга, а затем выполнить те же операции, что и в предыдущем 
случае. 

2.1. Треппинг шрифта. 
Шрифт, помещаемый в пределах изображений, представляет значительную 

трудность для печати. Особенно внимательно следует отнестись к мелкому кеглю. 
Необходимо избегать размещения мелкого кегля в изображениях, которые 

подвергаются растрированию. 
Треппинг мелкого шрифта в плашечной печати при малейшей погрешности 

приводки также создаст нечитаемый текст. Если шрифт темного цвета печатается на 
цветном фоне, стоит предпочесть надпечатку (overprint). Простое решение в этой 
ситуации эффективнее. 

Если размер шрифта превышает определенный предел, можно выполнять 
треппинг шрифта, поместив его копию под оригинал и увеличив толщину контура 
на определенную величину. 

В конце концов, шрифт с помощью команды Create Outlines (Преобразовать в 
контуры) меню Туре (Текст) можно конвертировать в кривые и применить к нему 
треппинг, как к любому графическому объекту. Разумеется, при этом будет утеряна 
возможность редактирования этого объекта как текста, а также преимущества 
шрифта при растрировании, которые обеспечивает ему технология хинтования 
(hinting). 

3. Надпечатка. 
В векторных программах, основанных на стандартах языка PostScript, 

принято, что цветные заливки не являются прозрачными.  
Из этого следует, что даже белый объект, который располагается поверх 

другого, вырезает у последнего соответствующую область, при плашечном 
цветоделении эти объекты попадают на разные полосы и затем в процессе печати с 
неточной приводкой могут образоваться небольшие непропечатанные области).  

Подобного дефекта можно избежать, если использовать флажки функции 
Overprint (Наложение) для заливки и для обводки в палитре Attributes (Атрибуты), 
установка которых обеспечивает печать объекта полностью, без "вырезания" 
областей вышележащих объектов.  
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Рис. 4.3. Исходные объекты и объекты, напечатанные без наложения цветов. 

 
Действие этой функции можно увидеть на экране, если активизировать 

функцию Overprint Preview (Отображение наложения цветов) меню View 
(Просмотр).  

Кроме того, команда Overprint Black (Наложение черного цвета) меню Filter 
> Colors (Фильтр > Цвета) позволяет установить или отменить режим нанесения 
черной краски поверх других элементов.  

Устанавливать режим наложения цвета необходимо в следующих ситуациях.  
1) Если требуется надпечатывать линии или другие мелкие элементы черного 

или темного цвета на цветном фоне. 
2) Если требуется сознательное смешение двух цветов. Например, подложка 

печатается 100%-ной пурпурной краской, а затей по ней же объект печатается 100%-
ной голубой, в результате окажется, что пересекающаяся область получится нового 
цвета, в данном случае фиолетового. 

Сознательность заключается в том, чтобы правильно рассчитать новый цвет и 
проверить, чтобы пересекающиеся таким образом объекты не имели общих 
цветовых компонентов.  

Для задания функции Overprint (Наложение) следует выделить требуемые 
объекты и в палитре Attributes (Атрибуты) установить флажок Overprint Fill 
(Наложение фона)).  

 

 
Рис. 4.4. Исходные и напечатанные объекты с установленным флажком Overprint 

Fill. 
 
Если функция Overprint (Наложение) применяется к заливке или контуру со 

100%-ным черным, то "силы" черной полиграфической краски может не хватить, 
чтобы перекрыть нижележащие цвета, особенно это может быть заметно, если 
черный объект одновременно располагается на цветном фоне и на белой бумаге.  

Для того чтобы присвоить или снять функцию надпечатки, необходимо 
выделить объект, который содержит определенный процент черного, и выполнить 
команду Overprint Black (Наложение черного цвета) меню Filter > Colors (Фильтр 
> Цвета), которая выводит на экран одноименное диалоговое окно.  
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Рис. 4.5. Диалоговое окно Overprint Black. 

 
В списке в верхней части диалогового окна представлены варианты:  
 1) Add Black (Наложение) - для добавления надпечатки (наложения) черного 

цвета;  
 2) Remove Black (Маскирование) - для удаления надпечатки (наложения) 

черного цвета.  
В поле Percentage (Порог) следует ввести процентное значение черного 

которое будет добавлено или удалено (маскировано). Например, следует ввести 80% 
для того, чтобы выделить объекты, содержащие по крайней мере 80% черного. 
Установка флажков Filll (К фону), Stroke (К линиям) в группе Apply to (Применить 
к) позволяет учитывать черный цвет только в заливках, только в обводках или 
заливках и обводках одновременно.  

Установка флажка Include Blacks with CMY (Включая черные, содержащие 
CMY) обеспечивает надпечатку для тех объектов, которые по сумме голубой, 
пурпурной и желтой красок образуют тот же процент черного, который указан в 
поле Percentage (Порог).  

Установка флажка Include Spet Blacks (Включая заказные черные цвета) 
обеспечивает надпечатку для объектов с плашечными цветами, имеющими тот же 
процент черного, который указан в поле Percentage (Порог). 

Выполнять треппинг и надпечатку следует на самой заключительной стадии, 
поскольку любые трансформации будут влиять на величину треппинга (например, 
масштабирование объекта вызовет пропорциональное изменение и для величины 
треппинга), что, разумеется, нежелательно. 

 
3.  ОБОРУДОВАНИЕ И МАТЕРИАЛЬНО-ТЕХНИЧЕСКОЕ ОБЕСПЕЧЕНИЕ 

Компьютерные классы, оборудованные ПК с установленным программным 
обеспечением не ниже: 

1) Операционная система  Windows XP; 
2) Менеджер файлов Total Commander 6.03 a; 
3) Векторный графический редактор Adobe Illustrator CS. 

 
4. ЗАДАНИЕ НА ЛАБОРАТОРНУЮ РАБОТУ 

Задание на лабораторную работу выдается в электронном виде. В качестве 
задания к лабораторной работе в папке «ТОИИ_Лр№00_задание» дан набор 
полноцветных векторных  изображений в формате ai и текстовый файл, содержащий 
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подрисуночную надпись для каждого варианта. Имя файла соответствует номеру 
варианта. Заданием на лабораторную работу является выполнение настройки 
параметров треппинга, соответствующих варианту задания.  

 
Варианты заданий для выполнения лабораторной работы 

№ 
вар. 

Цвет  заголовка Кегль 
заголовка

Цвет текста Неравномер-
ность 

растяжения 
1 PANTONE DS 265 60 #343815 98% 
2 #F7EFED 54 PANTONE DS 325 97% 
3 PANTONE DS 316 62 #F9F985 95% 
4 #D1D5D1 58 PANTONE DS 325 92% 
5 PANTONE DS 255 60 #3A2817 98% 
6 #D2D9D9 54 PANTONE DS 328 97% 
7 PANTONE DS 114 62 #3D2B17 95% 
8 #F9F1CB 58 PANTONE DS 228 92% 
9 PANTONE DS 29 60 #FAC3B8 98% 
10 #F6F9D7 54 PANTONE DS 326 97% 
11 PANTONE DS 12 62 #544230 95% 
12 #F9F985 58 PANTONE DS 202 92% 
 
 

5. ПОРЯДОК ВЫПОЛНЕНИЯ РАБОТЫ 
1) Сохранить оригинал на жестком диске, и открыть его с помощью 

программы Adobe Illustrator.  
2) На поле изображения с помощью инструментов группы Type (Текст) и 

палитры Character (Символ) создать заголовок заданного цвета и размера, согласно 
варианту задания. 

3) На поле фона с помощью инструментов группы Type (Текст) и палитры 
Character (Символ) создать сопроводительный текст заданного цвета. 

4) Произвести визуальный анализ изображения и оценить, для каких 
элементов следует применять треппинг, а для каких надпечатку. 

5) Треппинг произвести при помощи команды Trap (Треппинг) меню палитры 
Pathfinder (Обработка контуров) или с помощью команды Stroke (Обводка) 
палитры Stroke (Обводка), учитывая неравномерность растяжения бумаги – по 
вертикали она растягивается сильнее, чем по горизонтали. 

6) Произвести настройки надпечатки для выбранных элементов с помощью 
палитры Attributes (Атрибуты) или команды Overprint Black (Наложение черного 
цвета) меню Filter > Colors (Фильтр > Цвета).  

7) С помощью меню Print (Печать) согласно варианту задания произвести 
настройки цветоделения. 

8) Сохранить результат, как «Лр№04.ai». 
 

6. СОДЕРЖАНИЕ ОТЧЕТА 
Отчет о лабораторной работе сдается в электронном виде и должен содержать  

исходное изображение и изображение с выбранным треппингом и надпечаткой в 
формате ai. 
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7. КОНТРОЛЬНЫЕ ВОПРОСЫ 

1) Для чего предназначены метки обрезки? 
2) Какая информация о файле должна входить в аннотацию? 
3) На основании чего выбирается линиатура вывода штрихового 

изображения? 
 

8. БИБЛИОГРАФИЧЕСКИЙ СПИСОК 
1) Стефанов, С. Полиграфическое воспроизведение цветных изображений / 

С.Стефанов .— М. : Репроцентр-М, 2003 .— 32с. 
2) Залогова, Л.А. Компьютерная графика. Элективный курс : учеб.пособие / 

Л.А.Залогова .— М. : БИНОМ: Лаборатория знаний, 2005 .— 216с. 
3) Стефанов, С. Оценка печати оттисков / С.Стефанов;под ред.Ю.Стефановой 

.— М. : Репроцентр-М, 2003 .— 38с.  
4) Мэйрин, Д. Формат PDF в полиграфии : для вузов : пер. с англ. / Джозеф 

Мэйрин, Джули Шэффер ; науч. ред. и авт. доп. А. Голуенко .— М. : ПРИНТ-
МЕДИА центр, 2007 .— 248 с. 
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 Лабораторная работа № 5 (4 часа) 
РАСТРИРОВАНИЕ ПОЛУТОНОВОГО ИЗОБРАЖЕНИЯ.  

ЦВЕТОДЕЛЕНИЕ И РАСТРИРОВАНИЕ ПОЛНОЦВЕТНОГО  
ИЗОБРАЖЕНИЯ. 

 
1. ЦЕЛЬ И ЗАДАЧИ РАБОТЫ 

Цель работы: ознакомление с методами  растрирования цветоделенных 
изображений. 

Задачи работы: произвести корректное растрирование полутонового и 
цветоделенного изображений средствами растрового процессора Adobe Photoshop. 

 
2. ОСНОВНЫЕ ТЕОРЕТИЧЕСКИЕ СВЕДЕНИЯ 

1. Растрирование полутонового изображения. 
Растрирование - преобразование полутоновых и штриховых изображений в 

микроштриховые с помощью растра в репродукционных фотоаппаратах и 
контактно-копировальных станках. В компьютерных издательских системах 
растрирование проводят с использованием аппаратных и программных средств. 

 1.1. Линиатура и качество бумаги. 
Как правило, отпечаток, сделанный с высокой линиатурой, смотрится лучше, 

чем с низкой.  Однако, качество отпечатка определяется не только оригинал-
макетом, но и технологией печати. Растискивание -  Дефект, заключающийся в 
увеличении размеров штриховых и растровых печатных элементов на оттиске в 
процессе печатания; приводит к значительным градационным и цветовым 
искажениям репродукции. 

Для получения качественного отпечатка необходимо, чтобы точки растра не 
накладывались друг на друга. Если же линиатура растра велика, то растискивание 
приведет именно к этому и, вопреки ожиданию, качество отпечатка не возрастет, а 
ухудшится. Чем выше качество бумаги и чем более плотен ее верхний слой, тем 
большую линиатуру растра можно использовать при печати. Как правило, каждая 
типография предоставляет свои технические требования, но все они в той или иной 
мере близки к средним величинам. Приведем пример таких требований. 

ТАБЛИЦА 5.1. 

ЛИНИАТУРА И КАЧЕСТВО БУМАГИ 

БУМАГА ЛИНИАТУРА РАСТРА, LPI 

СРЕДНЕМЕЛОВАННАЯ БУМАГА  (MWC) 150 

ЛЕГКОМЕЛОВАННАЯ БУМАГА (LWC) 130 

ГАЗЕТНАЯ (NEWS) 90 

 
Достаточным разрешением растровых изображений является значение 

линиатуры вывода, умноженное на 1.5  Допускается увеличение разрешения 
растровых изображений до удвоенной линиатуры вывода.  

1.2. Растеризация в Photoshop. 
Photoshop способен самостоятельно проделывать растеризацию изображений, 

подобно тому, как это делает принтер или фотонаборный автомат. В результате из 
полутонового изображения (или канала полноцветного) получается монохромное. 
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Для этого служит команда Bitmap (Битовая карта) из списка режимов Mode 
(Режим) меню Image (Изображение). Для растрирования полутонового 
изображения следует: 

1) С помощью команды Bitmap (Битовая карта) меню Image (Изображение) 
открыть диалоговое окно определяющее способы преобразования полутонового 
изображения в монохромное. Линейному растрированию соответствует вариант 
Halftone Screen (Полутоновой растр).   

2) В поле Output (Вывод) указывается выходное разрешение (т. е. разрешение 
получающегося монохромного изображения). В информационном поле Input 
(Исходное) приведено разрешение исходного полутонового изображения, для того, 
чтобы  проконтролировать его достаточность для предполагаемой линиатуры 
печати. Потверждение настроек, щелчком на кнопке OK (Да) открывает диалоговое 
окно Half tone Screen (Полутоновый растр) с параметрами растрирования. 

3) В поле Frequency (Линиатура) следует ввести потребную линиатуру 
вывода. Следует убедиться, что в списке справа единицей измерения линиатуры 
выбраны в имперской системе единиц измерения. Угол растрирования в поле Angle 
(Угол) останется тем, что принят для черной краски - 45°. В списке Shape (Форма 
точки) устанавливается форма растровой точки.  После этого остается только 
подтвердить настройки щелчком на кнопке ОК. 

При выборе формы растровой точки следует учитывать, что круглые и 
квадратные точки имеют следующий  недостаток: соприкосновение соседних точек 
может происходить одновременно в четырех местах у круглых точек при 75%, а у 
квадратных точек при 50% заполнения поверхности. При использовании ярких 
печатных красок, в случае растрового поля с соединением соседних точек 
получается непропорциональное приращение плотности, которое особенно сильно 
проявляется в местах плавных переходов полутонов. 

Изображение растеризовано, но на экране оно покрыто каким-то затейливым 
узором. Это муар. Растр сетки люминофора монитора, накладываясь на растр самого 
изображения, и создает впечатление узора. Чтобы подробно рассмотреть растр, 
следует задайть масштаб демонстрации документа "пиксел в пиксел". При таком 
увеличении видимый муар исчезает. 

Если растеризованное изображение послать на печать, то растеризатор 
принтера не будет его обрабатывать повторно. 

 2. Цветоделение и растрирование. 
2.1. Растрирование цветоделенного изображения. 
Цветные документы представляют более сложный случай растрирования. 

Разделение цветного изображения на отдельные краски (компоненты) называется 
цветоделением. Каждый цвет растрируется отдельно с различными углами наклона 
растровой сетки. 

При горизонтальном или вертикальном расположении линий растра 
подчеркивается линейная структура последнего, и визуально растр более заметен. 
Традиционно угол наклона при печати монохромных документов и при печати 
плашечными цветами составляет 45° - это значение проверено временем, и 
обеспечивает наилучшую маскировку линейной структуры растра. 

Нанести триадные краски на лист без изменения угла наклона растра просто 
невозможно — в противном случае цветные точки, соответствующие базовым 
цветам, будут печататься поверх друг друга. Углы наклона растров для базовых 
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цветов подбираются таким образом, чтобы были видны все точки - без этого цвета 
не смогут визуально смешиваться внутри человеческого глаза, чтобы образовать 
нужный цвет. Конечно, и здесь не обойтись без частичного перекрытия точек друг 
другом, но, поскольку триадные краски полупрозрачны, в этом нет большой беды. В 
конечном итоге углы наклона растров должны быть такими, чтобы точки базовых 
цветов группировались в виде розеток. Каждую такую розетку можно рассматривать 
как некую метаточку цветного растра, образующую цвет в данной точке 
изображения. 

Есть еще одна причина, по которой углам наклона растров при печати 
триадными цветами приходится уделять столь существенное внимание. Если эти 
углы не согласованы, на изображении появляется муар.  

2.2. RT Screening. 
Рациональное растрирование было разработано во времена когда 

вычислительные мощности компьютеров и аппаратного обеспечения были 
невысокими. Вместо углов 15 и 75 градусов при рациональном растрировании 
используются углы с рациональным тангенсом. В математике рациональными 
принято называть числа, которые можно представить соотношением двух целых 
чисел. Тангенс угла a/b означает, что положение каждой следующей точки 
определяется отступом b шагов в сторону и a шагов вверх. 

  

 
Рис. 5.1. Пример формирования растра с тангенсом 1/3 (3 шага в сторону и 1 шаг 

вверх). 
 

В связи с жесткой привязкой рациональных методов растрирования к матрице 
пикселей фотонаборного автомата при рациональном растрировании каждой 
растровой ячейке (или группе ячеек) может быть присвоен адрес только на 
пересечении линии определяющей угол растра и физического пикселя 
фотонаборного автомата. Но расстояния между такими точками пересечений 
различны при различных углах. Таким образом оказываются допустимыми только 
некоторые комбинации разрешений и линиатур. Это связано с требованием точного 
расчета не только угла, но и линиатуры растра. Для рационального растрирования 
характерен следующий пример точности расчета углов и линиатур. 
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ТАБЛИЦА 5.2. 

УГЛЫ И ЛИНИАТУРЫ ПРИ РАЦИОНАЛЬНОМ РАСТРИРОВАНИИ. 

Краска Угол растра, º Линиатура, lpi 
Yellow 0 50.0 
Cyan 18.4 52.7 
Black 45.0 47.1 
Magenta 71.6 52.7 

2.3. Delta HQS. 
Рациональное растрирование по методу суперячейки является улучшением 

рационального растрирования. Оно основано на том, что используя большое 
количество растровых точек можно получить при расчете углов более высокую 
точность.  

 

 
Рис. 5.2. Пример формирования растра по методу суперячейки. 

 
Точность расчета углов и линиатур при этом методе возрастает. Внутри одной 

суперячейки уже возможны оба соотношения как 1/3 так и 1/4 для достижения более 
точного угла. Соотношение 1/3 дает угол больше 15 градусов а соотношение 1/4 
меньше. Таким образом комбинируя эти соотношения в определенной пропорции 
появляется возможность получить достаточно точный угол. Точность при этом 
зависит от размера суперячейки. Для HQS растрирования характерен следующий 
набор углов и линиатур:  

ТАБЛИЦА 5.3. 

УГЛЫ И ЛИНИАТУРЫ ПРИ РАСТРИРОВАНИИ ПО МЕТОДУ СУПЕРЯЧЕЙКИ. 

Краска Угол растра Линиатура, lpi 
Yellow 0 58.8 
Cyan 15.0013 58.9 
Black 45.0 58.9 
Magenta 74.9987 58.9 

Большинство растровых процессоров используют метод суперячейки. При 
этом точность расчета в растровых процессорах различных производителей может 
сильно отличаться в зависимости от размера используемой суперячейки. Точность 
расчета растра зависит от формата фотонаборного автомата и требуемой линиатуры. 
Экспериментально установлено, что ошибка менее четверти величины растровой 
точки не приводит к видимым проблемам.  

2.2. Параметры цветоделения. 
Настраивая цветовой профиль документа следует руководствоваться 

соображениями о том, как он в дальнейшем будет использоваться. Цветоделение в 
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Photoshop осуществляется путем установки параметров в окне Custom CMYK 
(Пользовательский CMYK) . 

Команда Edit > Color Settings (Правка > Параметры  цвета) вызывает меню 
настроек цветоделения.  

Рабочий профиль CMYK в диалоговом, окне Color Settings (Параметры 
цвета) как раз и задает параметры цветоделения в соответствии с выбранным 
полиграфическим стандартом. Таким образом, основная задача установок 
параметров цветоделения сводится к выбору верного профиля. Стандартные 
профили построены с учетом типа бумаги и печатной машины. Так, профили, в 
название которых входит слово Coated, предназначены для мелованной бумаги, a 
Uncoated - для обычной бумаги без покрытия. Профили, в которых фигурирует 
слово Sheetfed, соответствуют листовой подаче бумаги, а остальные - рулонной. 
Следует учитывать эти параметры при выборе профиля. 

Приведем пример технических требований по параметрам цветоделения. 

ТАБЛИЦА 5.4. 
Требования по параметрам цветоделения. 

Назначение 
изображения 

Растискивание растровой 
точки 

Общее красочное покрытие 

Для обложки 
 

Cyan от 14 до 21 % 
Magenta от 14 до 21 % 
Yellow от 14 до 21 % 
Black от 17 до 23 % 
 

До 300% 

 
Для блока 
 

Cyan от 12 до 18 % 
Magenta от 12 до 18 % 
Yellow от 14 до 20 % 
Black от 14 до 20 %  

 
До 340% 

 
В разделе Working Spaces (Рабочие пространства) из всплывающего меню 

CMYK следует выбрать характеристики, которые будут соответствовать 
выбранному устройству печати и типу бумаги.  

Если необходимо изменить параметры режима CMYK, то следует выбрать 
пункт Custom CMYK (Настройка CMYK) и  ввести имя нового набора параметров 
цвета, после чего  выбрать или ввести требуемые опции в разделе Ink Options 
(Параметры красок) для офсетной печати, такие как Ink Colors (Цвета красок) и 
Dot Gain (Растискивание).  

Другие характеристики офсетной печати вводятся в разделе Separation Options 
(Параметры цветоделения). Переключатель Separation Type (Тип цветоделения) 
дает программе Photoshop информацию о том, какой алгоритм используется при 
печати: метод GCR (Gray Component Replacement - Замещение серого компонента) 
или UCR (Undercolor Removal - Удаление паразитных цветов), и как используется 
черная краска.  

Опция Black Generation (Содержание черного) регулирует содержание черной 
краски при преобразовании RGB-составляющих в краски CMY. Черная краска 
заменяет определенную долю CMY-красок, чтобы предотвратить получение 
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грязного цвета при смешивании. Значение в поле Black Generation определяет, какое 
количество черной краски используется для замены.  

2.3. Растеризация цветоделенного изображения. 
Доступ к параметрам растрирования осуществляется щелчком на кнопке 

Screens (Растры) в диалоговом окне Print with Prewiew (Печать с 
предпросмотром). При этом открывается диалоговое окно Halftone Screens 
(Полутоновой растр). Состояние флажка Use Printer's Default Screens 
(Использовать растр принтера) определяет, кто будет растрировать изображение 
при печати. Если он установлен, то растеризацию осуществляет принтер. В 
противном случае это будет делать Photoshop в соответствии с параметрами, 
задаваемыми ниже в окне. 

Список Ink (Краски) позволяет выбрать форму, для которой задаются 
параметры растрирования. Их всего три: линиатура растра (поле Frequency 
(Линиатура)), угол растра (поле Angle (Угол)) и форма растровой точки (поле Shape 
(Форма растровой точки)). Следует учитывать, что параметры растрирования 
задаются независимо для каждой краски. Текущая краска выбирается в списке Ink 
(Краски).  

Кнопка Auto (Авто) в диалоговом окне Halftone Screens (Полутоновый растр) 
"помогает" рассчитать линиатуры и углы растра для отдельных красок, исходя из 
разрешения устройства вывода и предполагаемой линиатуры печати. Также можно  
установить флажок Use Accurate Screens (Точные растры высокого разрешения), 
чтобы линиатуры растра были одинаковыми для всех красок. 

Параметры растрирования можно сохранить в файле *.ahs, чтобы избежать в 
дальнейшем повторного ввода.  

 
3.  ОБОРУДОВАНИЕ И МАТЕРИАЛЬНО-ТЕХНИЧЕСКОЕ ОБЕСПЕЧЕНИЕ 

Компьютерные классы, оборудованные ПК с установленным программным 
обеспечением не ниже: 

1) Операционная система  Windows XP; 
2) Менеджер файлов Total Commander 6.03 a; 
3) Растровый графический редактор Adobe Photoshop CS. 

 
4. ЗАДАНИЕ НА ЛАБОРАТОРНУЮ РАБОТУ 

Задание на лабораторную работу выдается в электронном виде. В качестве 
задания к лабораторной работе в папке «ТОИИ_Лр№03_задание» дан набор 
полноцветных растровых изображений в формате tif. Имя файла соответствует 
номеру варианта. Заданием на лабораторную работу является растрирование 
полутонового и полноцветного изображения с параметрами, соответствующими 
варианту задания, с сохранением профилей растрирования и цветоделения.  
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Варианты заданий для выполнения лабораторной работы. 
Номер варианта Тип бумаги Цель Тип 

растрирования 
Размер оттиска, 

см. 
1 MWC Обложка Рациональное 8х5,67 
2 LWC Блок Рациональное 10х7,09 
3 NEWS Обложка Рациональное 15х10,64 
4 MWC Блок Рациональное 9х6,38 
5 LWC Обложка Рациональное 10,5х7,45 
6 NEWS Блок Рациональное 14х9,93 
7 MWC Обложка Иррациональное 7х4,96 
8 LWC Блок Иррациональное 9х7,6,38 
9 NEWS Обложка Иррациональное 13х9,22 
10 MWC Блок Иррациональное 8,5х6,03 
11 LWC Обложка Иррациональное 9,5х6,74 
12 NEWS Блок Иррациональное 14,5х10,28 

 
5. ПОРЯДОК ВЫПОЛНЕНИЯ РАБОТЫ 

1) Сохранить оригинал на жестком диске, и открыть его с помощью 
программы Adobe Photoshop.  

2) С помощью меню Image>Mode>Grayscale 
(Изображение>Режим>Градации серого ) преобразовать оригинал в полутоновый. 

3) С помощью меню Image>Adjustment>Levels (Изображение> Коррекция 
>Уровни) отрегулировать распределение оптических плотностей таким образом, 
чтобы отсутствовало пропадание деталей. 

4) На основании исходных данных рассчитать линиатуру вывода. 
5) На основании исходных данных о размере репродукции рассчитать 

потребное разрешение изображения и пиксельные размеры изображение. 
Установить параметры с помощью меню Image>Image size (Изображение>Размер 
изображения). 

6) Выполнить растеризацию изображения с рассчитанной линиатурой. Через 
меню Image>Mode>Bitmap (Изображение>Режим>Битовая карта) инициировать 
преобразование изображения в битовую карту. Для растрирования выбрать вариант 
Halftone Screen (Полутоновый растр). 

7) Выбрать форму растровой точки. Разрешение выводного устройства 
установить равным 2400 dpi. Сохранить профиль растрирования, как 
«Лр№05_полутон_растр_le.ahs». 

8) Сохранить результирующее изображение, как «Лр№05_le.eps». 
9) Заново открыть оригинал и повторить действия п. 4,5, но для 

полноцветного изображения. 
10) Выполнить настройки цветоделения для CMYK с помощью меню Edit > 

Color Settings (Правка > Параметры  цвета). 
11) Создать пользовательский профиль CMYK. Установить для него тип 

бумаги, краски и растискивание соответственно варианту задания. 
12) Сохранить настройки цветоделения, как «Лр№05_цветоделение_le.csf». 
13) С помощью меню Print with Prewiew>Screens (Печать с 

предпросмотром>Растры) выполнить настройки растрирования цветоделенного 
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изображения. Параметры растрирования, в частности угол, установить согласно 
варианту задания. Остальные параметры устанавливаются аналогично п. 7. 

14) Сохранить профиль растрирования «Лр№05_цвет_растр_le.ahs».  
 

6. СОДЕРЖАНИЕ ОТЧЕТА 
Отчет о лабораторной работе сдается в электронном виде и должен содержать: 
1) исходное изображение; 
2) профиль растрирования полутонового изображения в формате ahs; 
3) растрированное полутоновое в формате eps; 
4) настройки цветоделения в формате csf; 
5) профиль растрирования цветоделенного изображения в формате ahs. 

 
7. КОНТРОЛЬНЫЕ ВОПРОСЫ 

1)Что такое растрирование? 
2) В чем различие рационального и иррационального растрирования? 
3) Чем обусловлено появление метода иррационального растрирования? 
4) Почему недопустимо растрирование цветоделенного изображения  теми же 

методами, что и тонового? 
 

8. БИБЛИОГРАФИЧЕСКИЙ СПИСОК 
1) Стефанов, С. Изображения: градация и цвет / С.Стефанов .— М. : 

Репроцентр М, 2005 .— 48с. 
2) Стефанов, С. Полиграфическое воспроизведение цветных изображений / 

С.Стефанов .— М. : Репроцентр-М, 2003 .— 32с. 
3) Стефанов, С. Цветное изображение на оригинале, мониторе компьютера и 

на полиграфическом оттиске / С.Стефанов;под ред.Ю.Стефановой .— М. : 
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Лабораторная работа № 6 (4 часа) 
ОБРАБОТКА ДУПЛЕКСНЫХ ИЗОБРАЖЕНИЙ. 

 
1. ЦЕЛЬ И ЗАДАЧИ РАБОТЫ 

Цель работы: Ознакомление с методами  создания и обработки дуплексных 
изображений. 

Задачи работы: Произвести преобразование цветного изображения в 
дуплексное средствами Adobe Photoshop. 

 
2. ОСНОВНЫЕ ТЕОРЕТИЧЕСКИЕ СВЕДЕНИЯ 

Изображения, при печати которых используются две краски, получили 
название дуплексных, а цветовые модели, предназначенные для их хранения и 
обработки - Duotone.  

Изначально, дуплексная печать была разработана полиграфистами-
профессионалами для расширения тонового диапазона репродуцируемых 
монохромных оригиналов - например, старинных черно-белых фотографий. 
Воспроизведение такого оригинала с использованием только одной черной краски 
на практике часто приводило к тому, что он в результате печати оказывался 
достаточно "беден" в градационном плане и был малоинтересен для зрителя. 
Поэтому, профессионалами был предложен способ репродуцирования одного черно-
белого оригинала - через его воспроизведение с использованием нескольких 
базовых красок.  

Конвертировать в формат Duotone можно не любое изображение, а только 
изображение в формате Grayscale (Градации серого). Именно поэтому, при создании 
дуплекса на основе полноцветного изображения следует сначала преобразовать  его 
в полутоновое, а потом, выполнив коррекцию градационного содержания 
изображения уже создавать на его основе дуплекс. 

После создания и редактирования необходимого полутона следует выбрать 
пункт Mode (Режим) из меню Image (Изображение) и выполнить команду Duotone 
(Дуплекс)  На экран выводится диалоговое окно Duotone Options (Параметры 
Дуплекса).  

 

 
Рис. 6.1.  Диалоговое окно Duotone Options. 

 
В строке Type (Тип) следует задать число красок, которыми будет печататься 

изображение. Значение Monotone (Однотонный) соответствует полутоновому 
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изображению, напечатанному в одну краску. По умолчанию принят однотоновый 
тип, причем печатающая краска - черная. 

В правой части диалогового окна есть флажок Preview (Предпросмотр). Его 
установка позволяет заранее просмотреть результат.  

Хотя однотоновый дуплекс черной краской по сути тождественен 
полутоновому изображению, отличие между ними существует. Более того, в 
Photoshop это отличие становится очевидным: при установке флажка Preview 
(Предпросмотр) (изображение меняет тон. Дело в том, что дуплекс ориентирован на 
типографскую печать, а не на просмотр на экране, и использует цветовую модель 
типографских машин CMYK.  

Ниже расположены строки для определения красок. Справа - поле имени 
краски. Левее имени находится образец цвета, который можно переопределять. Если 
щелкнуть на образце цвета, откроется диалоговое окно Color Picker (Выбор цвета) в 
котором следует выбрать нужный цвет. После нажатия кнопки ОК  изображение из 
черно-белого станет тонированным. Остается только назвать цвет, набрав в строке 
имя.  

Дуплекс печатается плашечной краской, а не красками CMYK. Поэтому при 
печати дуплексом обычно указывают не просто образец краски в палитре цветов с 
произвольным именем, а конкретный цвет из стандартного цветового каталога. Для 
того чтобы выбрать краску из каталога, следует снова открыть диалоговое окно 
Color Picker (Выбор цвета)  и нажать кнопку Custom (Пользовательский) - 
откроется диалоговое окно Custom Colors (Пользовательские цвета). Программа по 
умолчанию выбирает из текущего каталога цвет, наиболее близкий выбранному в 
палитре. Одновременно изображение тонируется этим цветом. После нажатия 
кнопки ОК цвет образца изменится, одновременно изменится и имя. Теперь цвет 
краски имеет стандартное название, и его можно найти по каталогу.  

Рядом с образцом цвета расположена миниатюра распределения краски при 
печати- Она представляет собой уменьшенное изображение градационной  кривой. 
Эта кривая отображает, сколько краски будет нанесено на изображение во всем 
диапазоне градаций серого. Прямая диагональ свидетельствует о равномерном 
(линейном) распределении. Щелчком на отображении градационной кривой на 
экран выводится диалоговое окно Duotone Curve (Кривая Дуплексной Краски). В нем 
представлен график (собственно градационная кривая) и поля ввода процентного 
распределения краски по диапазонам.  

 

 
Рис. 6.2. Редактирование градационной кривой дуплексной краски. 
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Если щелкнуть мышью на прямой примерно посередине и оттянуть ее вверх, 
процент краски в средних тонах возрастает, изображение станнет темнее. Если 
буксировать курсор вниз, то эффект будет обратным, изображение осветляется.  

Данная кривая, как и всякая градационная кривая, отображает (и определяет) 
по оси Y значения плотности краски, а по оси Х — градации серого: от белого слева 
до черного справа. Если вводить различные значения в поля ввода или менять 
форму кривой вручную, то распределение краски будет происходить по заданной 
вами формуле кривой. Если график не прямая диагональ, то это означает, что 
некоторые тональные уровни используют меньше (или больше) краски, чем 
исходный оригинал.  

Как и в других диалоговых окнах, имеющих градационные кривые, их 
параметры можно сохранять для дальнейшего использования. 

Перейдем к двухтоновому дуплексу и посмотрим, как влияет увеличение 
числа красок на изобразительные возможности.  

Следует выбрать в списке Type (Тип)  пункт Duotone (Дуплекс). Теперь 
доступны две строки краски Во второй строке щелкнув на образце цвета и выбрав  
вторую  краску, следует также подбирать ближайшую к нему краску из каталога. 
Теперь виден  эффект дуплекса. Распределение второй краски так же следует 
отрегулировать. 

Найденные параметры дуплекса можно сохранить в специальном файле и 
далее использовать для других изображений. Для сохранения дуплекса следует 
нажать кнопку Save (Сохранить)  диалогового окна Duotone Options  (Параметры 
Дуплекса). В диалоговом окне сохранения вводится имя. Подобные файлы имеют 
расширение ADO.  

Теперь, открыв какой-нибудь файл можно применить к данному файлу 
найденную формулу дуплекса. Для этого следует открыть диалоговое окно Duotone 
Options (Параметры Дуплекса) и нажать кнопку Load (Загрузить). В стандартном 
диалоговом окне загрузки файла выбрать файл нужного дуплекса и нажать кнопку 
Load (Загрузить).  

Инсталляционный набор программы Adobe Photoshop имеет значительное 
количество готовых параметров дуплекса, сохраняемых в файлах с расширением 
ado. Они находятся в специальном каталоге Duotones. 

  
3.  ОБОРУДОВАНИЕ И МАТЕРИАЛЬНО-ТЕХНИЧЕСКОЕ ОБЕСПЕЧЕНИЕ 

Компьютерные классы, оборудованные ПК с установленным программным 
обеспечением не ниже: 

1) Операционная система  Windows XP; 
2) Менеджер файлов Total Commander 6.03 a; 
3) Растровый графический редактор Adobe Photoshop CS. 
 

4. ЗАДАНИЕ НА ЛАБОРАТОРНУЮ РАБОТУ 
Задание на лабораторную работу выдается в электронном виде. В качестве 

задания к лабораторной работе в папке «ТОИИ_Лр№04_задание» дан набор 
полноцветных растровых изображений в формате jpg. Имя файла соответствует 
номеру варианта. Заданием на лабораторную работу является создание дуплексного 
изображения с параметрами, соответствующими варианту задания и описание 
процесса.  
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Варианты заданий для выполнения лабораторной работы 
Номер варианта Краска для теней Краска для светов 

1 FOCOLTONE 3416 FOCOLTONE 1020 
2 FOCOLTONE 3507 FOCOLTONE 1048 
3 FOCOLTONE 3413 FOCOLTONE 1072 
4 FOCOLTONE 3502 FOCOLTONE 1162 
5 FOCOLTONE 3415 FOCOLTONE 2255 
6 FOCOLTONE 6047 FOCOLTONE 5003 
7 FOCOLTONE 7069 FOCOLTONE 5004 
8 FOCOLTONE 6053 FOCOLTONE 4037 
9 FOCOLTONE 7067 FOCOLTONE 1012 
10 FOCOLTONE 6054 FOCOLTONE 1060 
11 FOCOLTONE 6046 FOCOLTONE 2207 
12 FOCOLTONE 3472 FOCOLTONE 1004 

 
 

5. ПОРЯДОК ВЫПОЛНЕНИЯ РАБОТЫ 
1) Сохранить оригинал на жестком диске, и открыть его с помощью 

программы Adobe Photoshop.  
2) С помощью меню Image>Mode>Grayscale 

(Изображение>Режим>Градации серого ) преобразовать оригинал в полутоновый. 
3) С помощью меню Image>Adjustment>Levels (Изображение> Коррекция 

>Уровни) отрегулировать распределение оптических плотностей таким образом, 
чтобы максимально разделить области светов и теней. 

4) С помощью меню Image>Mode>Doutone (Изображение>Режим>Дуплекс) 
инициировать преобразование изображения в дуплексное. 

5) Создать двухкрасочное дуплексное изображение, выбрав краски для цветов 
и теней согласно варианту задания. 

6) Отрегулировать распределение краски. 
7) Сохранить настройки преобразования в дуплекс, как  «Лр№04_le.ado». 
8) Сохранить дуплексное изображение, как  «Лр№06_le.psd». 

 
6. СОДЕРЖАНИЕ ОТЧЕТА 

Отчет о лабораторной работе сдается в электронном виде и должен содержать 
исходное изображение, настройки преобразования в дуплекс в формате ado и 
дуплексное изображения в формате psd.   

 
7. КОНТРОЛЬНЫЕ ВОПРОСЫ 

1)Что такое дуплекс? 
2) В каких случаях используются дуплексные изображения? 
3) Для чего служит настройка градационных кривых дуплексных красок? 
 

8. БИБЛИОГРАФИЧЕСКИЙ СПИСОК 
1) Стефанов, С. Изображения: градация и цвет / С.Стефанов .— М. : 

Репроцентр М, 2005 .— 48с. 
2) Стефанов, С. Полиграфическое воспроизведение цветных изображений / 

С.Стефанов .— М. : Репроцентр-М, 2003 .— 32с. 
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3) Стефанов, С. Цветное изображение на оригинале, мониторе компьютера и 
на полиграфическом оттиске / С.Стефанов;под ред.Ю.Стефановой .— М. : 
Репроцентр-М, 2003 .— 64с. 
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 Лабораторная работа № 7 (3 часа) 
НАСТРОЙКА ПАРАМЕТРОВ ВЫВОДА ШТРИХОВОГО ИЗОБРАЖЕНИЯ. 

 
1. ЦЕЛЬ И ЗАДАЧИ РАБОТЫ 

Цель работы: ознакомление с методами  настройки вывода штриховых 
изображений. 

Задачи работы: произвести настройку вывода штрихового изображения. 
Выбрать формат бумаги, расставить метки обреза. 

 
2. ОСНОВНЫЕ ТЕОРЕТИЧЕСКИЕ СВЕДЕНИЯ 

1. Установка параметров страницы. 
Под форматом печатной страницы (artboard size) понимается максимальный 

размер листа, используемый на внешнем устройстве. Эти размеры не следует путать 
с размерами печатной области, которую в состоянии запечатать выводное 
устройство. Для того чтобы изменить стандартный формат или установить 
произвольный размер печатной страницы, необходимо вызвать на экран диалоговое 
окно Document Setup (Параметры документа), выполнив одноименную команду 
меню File (Файл). 

 

 
Рис. 7.1. Диалоговое окно Document Setup при выборе варианта Artboard 
 
Программа дает возможность "подстройки" к текущему принтеру: если 

установить флажок Use Print Setup (По размеру страницы), то формат документа 
будет использовать параметры бумаги активного принтера. В списке Units 
(Единицы) можно установить другую единицу измерения, выбрав один из 
вариантов. И, наконец, две кнопки в поле Orientation (Ориентация) позволяют 
определить расположение документа на печатной странице: книжная (включена по 
умолчанию) или альбомная. 

После нажатия кнопки ОК на экране отображается прямоугольник, 
представляющий рабочую страницу с соответствующими параметрами. 

По умолчанию программа Adobe Illustrator использует размеры страницы, 
определяемые PPD-файлом установленного принтера. Пользователь может изменить 
размеры страницы, выбрав другой вариант из списка Page Size (Формат) 
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диалогового окна Separation Setup (Параметры цветоделения) диалогового окна 
Print (Печатать) меню File (Файл). Размеры страниц имеют стандартные имена, 
например А4 и пр.; размеры, приведенные в скобках, обозначают параметры 
печатного поля. При выборе размера страницы необходимо обращать внимание на 
эти параметры, иначе метки обреза, приводки и другая чрезвычайно важная 
служебная информация может оказаться ненапечатанной. 

В раскрывающемся, списке Orientation (Ориентация) представлены два 
варианта ориентации:   

1)  Portrait (Книжная) - располагает отпечаток вдоль короткой стороны листа; 
2)  Landscape (Альбомная) - располагает отпечаток вдоль длинной стороны 

листа. 
Если в списке Page Size (Формат) имеется вариант Custom 

(Пользовательский), в диалоговом окне Custom Page Size (Произвольный формат 
страницы)  можно установить размер, отличный от стандартного. 

 В полях Width (Ширина) и Height (Высота) устанавливаются значения 
ширины и высоты страницы, а в поле Offset (Смещение) - значение сдвига страницы. 
Значение сдвига определяет расстояние в пунктах от правой стороны определяемой 
страницы до правой границы листа. 

 Флажок Transverse (Под углом 90 градусов) служит для поворота страницы на 
90 градусов против часовой стрелки. Этот флажок может быть чрезвычайно 
полезным для более, рационального использования фотопленки в фотонаборных 
автоматах. В раскрывающемся списке Emulsion (Эмульсия) предлагается выбор 
прямого или зеркального отображения цветоделенных полос на плёнке. В 
раскрывающемся списке Image (Изображение) определяется негативный или 
позитивный способ вывода на пленку. Расположение эмульсии и способ вывода на 
пленку определяются технологическим процессом полиграфической печати. 

 Флажок Overprint Black (Наложение черного), установленный в диалоговом 
окне Separation on (Цветоделение), представляет собой самый простой способ 
наложения черного цвета. В поле Bleed (Выпуск за обрез) устанавливается значение 
"перехлеста" изображения и поля, определяемого метками обреза, в диапазоне от 0 
до 72 пунктов (по умолчанию принимается значение в 18 пунктов).  

2. Метки обреза. 
Метки обреза (crop marks) наносятся на печатный лист и служат границей 

страницы, по которой происходит обрезка листа в типографии Эти метки можно 
легко создать с помощью команды Make (Разместить) меню Object > Crop Marks 
(Объект > Метки обреза). Они будут автоматически отображены на цветоделенных 
полосах, если установить флажок Use Printer"s Marks (Метки по умолчанию) в 
диалоговом окне Separation Setup (Цветоделение). 

Помимо простых меток обреза существуют так называемые "японские метки 
обреза" (Japanese-style crop marks), которые будут размещаться в документе, если в 
разделе General (Основные) диалогового окна Preferences (Установки) установить 
флажок Japanese Crop Marks (Японские метки обреза). 
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Рис. 7.2. Простые и японские метки обреза. 

 
По умолчанию программа Adobe Illustrator устанавливает метки обреза по 

краю страницы, Поэтому такие метки могут не попасть на распечатку, выполненную 
принтером. Они предназначены для вывода цветоделенных полос в фотонаборных 
автоматах на пленку, формат которых позволяет отобразить множество служебной 
информации и метки, необходимые в процессе полиграфического исполнения. 

Если все-таки требуется установить метки обреза в пределах страницы, 
необходимо поступить следующим образом. 

 С помощью инструмента Rectangle (Прямоугольник) очертить нужную 
область, при этом внешние параметры прямоугольника (цвет обводки и заливки) не 
имеют значения. 

Выделив прямоугольник, выполнить команду Make (Разместить) меню 
Object > Crop Marks (Объект > Метки обреза), которая заменит прямоугольник на 
метки обреза. 

Эти метки ни выделить, ни переместить невозможно, поэтому, если требуется 
изменить положение меток или отказаться от них, следует выполнить команду 
Release (Убрать), меню Object > Crop Marks (Объект > Метки обреза). 

В то же время существуют ситуации, например при печати визитных карточек, 
когда на одном листе требуется более десятка меток обреза. Правильнее сказать, 
меток "разрезки". 

В этом случае необходимо использовать команду Trim Marks (Метки 
разрезки) меню Filter > Create (Фильтр > Создание), позволяющую вокруг 
выделенных объектов, по краям прямоугольника, в который можно вписать эти 
объекты, расставить метки разрезки. 

Получаемые в результате метки являются группой векторных объектов, 
которые можно перемещать и трансформировать как обычные объекты. 
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Рис. 7.3. Метки разрезки вокруг изображений. 

 
3.Соотношение разрешения и линиатуры. 
Соотношение существующего разрешения выводного устройства и задаваемой 

линиатуры растра может привести к тому, что количество возможных оттенков, 
передаваемых при этих условиях, окажется много меньше 256. 

Приведенная ниже таблица (табл1) поможет выбрать приемлемую линиатуру 
растра для обеспечения 256 оттенков серого цвета. 

Таблица 1. 
Приемлемая линиатура растра для 256 оттенков серого цвета. 

Разрешение 
выводного 

устройства (dpi) 

Максимальная 
линиатура (lpi) 

Разрешение 
выводного  

устройства (dpi) 

Максимальная 
линиатура (lpi) 

300 19 600 38 
400 25 900 56 
1000 63 2400 150 
1270 79 2540 159 
1446 90 3000 188 
1524 95 3252 203 
1693 106 3600 225 
2000 125 4000 250 

 
При этом следует иметь в виду, что обеспечение 256 оттенков серого цвета 

отнюдь не свидетельствует о хорошем качестве изображения, например в передаче 
мелких деталей, особенно на устройствах с низкой разрешающей способностью. 
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В раскрывающемся списке Halftone (Растр) диалогового окна Separations on 
(Цветоделение) предлагается набор линиатур и разрешений, доступных для 
текущего принтера или фотонаборного автомата. Для установки произвольного 
значения линиатуры для отдельной цветоделенной полосы нужно выделить ее имя в 
списке, а затем в полях Frequency (Линиатура) и Angle (Угол) определить 
необходимые значения линиатуры и угла наклона растра. 

Следует только иметь в виду, что в файле PPD представлены 
оптимизированные значения линиатур и углов наклона растра для данного 
выводного устройства, изменение значения которых может быть чревато 
значительными погрешностями печати (в частности, появлением паразитного узора 
— муара). 

4. Аннотации к объектам и файлу 
Вот примерная информация, которой следует сопроводить передаваемый 

файл: 
1) название файла;  
2) его формат;  
3) версия программы, в которой документ создан;  
4) геометрические размеры;  
5) количество страниц и количество использованных цветов, включая 

плашечные.  
В наше время наиболее логичным вариантом решения этой проблемы является 

присоединение всей этой информации непосредственно к файлу в виде аннотации. 
Аннотации можно присовокупить также и к файлу в целом, в частности 

авторскую информацию, так называемые метаданные. Для этого командой File Info 
(Информация о файле) меню File (Файл) на экран вызывается одноименное 
диалоговое окно с несколькими разделами. 
В разделе General (Общий) представлены параметры, сохраняющие общую 
информацию о документе, его авторе и его авторских правах: 

1) Title (Название документа); 
2) Author (Автор); 
3) Description (Описание);  
4) Job Name (Рабочее название); 
5) Copyrighted (Авторское право ) с вариантами Yes (Да), No (Нет), Unknown 

(неизвестно); 
6) Copyright Notice (Уведомление об авторском праве); 
7) Owner URL (URL владельца), кнопка Go To URL (Перейти на адрес). 
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Рис. 7.4. Раздел General диалогового окна File Info. 

 
В разделе Keywords (Ключевые слова) можно сохранить ключевые слова, 

которые  позволят облегчить поиск документа. 
В поле Keyword (Ключевое слово) вводятся необходимые слова, кнопка Add 

(Добавить) переносит их в основное поле, кнопки Replace (Заменить) и Delete 
(Удалить) служат для редактирования содержания списка ключевых слов. 

В разделе Summary (Итоговая информация) отображается информация о 
файле, в частности даты его создания (Creation Date) и изменения ( Modification 
Date), а так же  местоположение (Local File). Если файл включен в произвольный  
поток,  указывается адрес сервера и текущий статус обработки документа. Данные 
поля не подлежат изменению. 

Метаданные сохраняются в форматах AI, PDF и SVG. 
 

3.  ОБОРУДОВАНИЕ И МАТЕРИАЛЬНО-ТЕХНИЧЕСКОЕ ОБЕСПЕЧЕНИЕ 
Компьютерные классы, оборудованные ПК с установленным программным 

обеспечением не ниже: 
1) Операционная система  Windows XP; 
2) Менеджер файлов Total Commander 6.03 a; 
3) Векторный графический редактор Adobe Illustrator CS. 

 
4. ЗАДАНИЕ НА ЛАБОРАТОРНУЮ РАБОТУ 

Задание на лабораторную работу выдается в электронном виде. В качестве задания к 
лабораторной работе в папке «ТОИИ_Лр№07_задание» дан шаблон визитной 
карточки. Заданием на лабораторную работу явлется создание собственной 
карточки, ее тиражирование на печатный лист и настройка параметров вывода, 
соответствующих номеру варианта.  
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Варианты заданий для выполнения лабораторной работы 
№ 

вар. 
Формат 
бумаги, 

см 

Ориента-
ция бумаги 

Способ 
вывода на 

пленку 

Размер 
визитки, 

мм 

Размеры 
печатных 
полей, мм 

Разрешение 
выводного 
устройства 

(dpi) 
1 А4 Книжная Негативный 90х50 10 1000 
2 А3 Книжная Негативный 80х40 7 1270 
3 А4 Альбомная Негативный 90х50 5 1446 
4 А3 Альбомная Негативный 80х40 10 1524 
5 А4 Книжная Негативный 90х50 7 1693 
6 А3 Книжная Негативный 80х40 5 2000 
7 А4 Альбомная Позитивный 90х50 10 1000 
8 А3 Альбомная Позитивный 80х40 7 1270 
9 А4 Книжная Позитивный 90х50 5 1446 
10 А3 Книжная Позитивный 80х40 10 1524 
11 А4 Альбомная Позитивный 90х50 7 1693 
12 А3 Альбомная Позитивный 80х40 5 2000 

 
5. ПОРЯДОК ВЫПОЛНЕНИЯ РАБОТЫ 

1) Открыть шаблон визитной карточки с помощью программы Adobe 
Illustrator. 

2) На основании шаблона визитной карточки создать свою собственную 
визитную карточку (карточка должна содержать только черный цвет и оттенки 
серого).  

3) Размер ограничивающего прямоугольника установить согласно варианту 
задания. 

4) С помощью инструментов группы Type (Текст) и палитры Character 
(Символ) изменить текст. 

5) С помощью меню File > Document Setup (Файл > Параметры документа) 
установить размер документа и способ вывода согласно варианту задания. 

6) Согласно варианту задания, рассчитать сколько визитных карточек 
разместится на листе с учетом печатных полей.  

7) Установить метки разрезки для ограничивающего прямоугольника 
визитной карточки с помощью команды Trim Marks (Метки разрезки) меню Filter > 
Create (Фильтр > Создание). 

8) Используя палитру Layers (Слои) растиражировать слой с визитной 
карточкой по всему листу. 

9) С помощью палитры Align (Выравнивание) выровнять их расположение. 
10) С помощью пункта Output (Вывод) меню Print (Печать) согласно варианту 

задания установить линиатуру вывода, разрешение вывода и другие параметры. 
Сохранить настройки печати как как «Лр№08». 

11) Создать аннотацию к документу с помощью команды File Info 
(Информация о файле) меню File (Файл). 

12) Сохранить документ, как «Лр№07_le.ai». 
 
 
 



 54

6. СОДЕРЖАНИЕ ОТЧЕТА 
Отчет о лабораторной работе сдается в электронном виде и должен содержать 

подготовленный к выводу спуск полосы с визитными карточками в формате ai. 
 

7. КОНТРОЛЬНЫЕ ВОПРОСЫ 
1) Для чего предназначены метки обрезки? 
2) Какая информация о файле должна входить в аннотацию? 
3) На основании чего выбирается линиатура вывода штрихового 

изображения? 
 

8. БИБЛИОГРАФИЧЕСКИЙ СПИСОК 
1) Стефанов, С. Изображения: градация и цвет / С.Стефанов .— М. : 

Репроцентр М, 2005 .— 48с. 
2) Стефанов, С. Полиграфическое воспроизведение цветных изображений / 

С.Стефанов .— М. : Репроцентр-М, 2003 .— 32с. 
3) Стефанов, С. Цветное изображение на оригинале, мониторе компьютера и 

на полиграфическом оттиске / С.Стефанов;под ред.Ю.Стефановой .— М. : 
Репроцентр-М, 2003 .— 64с. 
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Лабораторная работа № 8 (3 часа) 
ЦВЕТОДЕЛЕНИЕ ПОЛНОЦВЕТНОГО ШТРИХОВОГО ИЗОБРАЖЕНИЯ. 

 
1. ЦЕЛЬ И ЗАДАЧИ РАБОТЫ 

Цель работы: ознакомление с методами  цветоделения штриховых 
изображений. 

Задачи работы: произвести настройку разделения триадных и плашечных 
красок штрихового изображения средствами Adobe Illustrator.  

 
2. ОСНОВНЫЕ ТЕОРЕТИЧЕСКИЕ СВЕДЕНИЯ 

1. Системы управления цветом. 
1.1. Управление цветом в программе Adobe Illustrator. 
Программа Аdоbе Illustrator включает систему управления цветом, которая 

позволяет контролировать работу с цветом на экранt монитора и при выводе на 
внешние печатные устройства. 

Система управления цветом использует стандарты, разработанные 
Международным консорциумом по цвету (International Color Consortium - ICC), что 
обеспечивает Должное отображение цвета на экране монитора и должное 
репродуцирование полиграфическим способом, а кроме того - полное цветовое 
единство с программами Adobe Photoshop, Adobe PageMaker и Adobe InDesign. 

Система управления цветом основана на едином цветовом пространстве, 
которое обеспечивается использованием цветовой модели Lab. 

Вторым важным компонентом системы управления цветом являются цветовые 
профили используемых устройств - файлы, описывающие соответствие цветов 
устройств ввода или вывода в терминах цветовой модели Lab. 

И наконец, компонентом, обеспечивающим непосредственно управление, 
служит так называемая "машина цветового соответствия" (color-matching engine).  

Существующие системы управления цветом снабжаются довольно обширной 
базой цветовых профилей для различных типов устройств (принтеров) и почти 
никогда профилями для стандартных печатных машин, а для настольных систем не 
«существует возможности создавать такие профили применительно к конкретным 
устройствам. И если система управления цветом не поддерживает какое-либо 
устройство, пользователь лишен возможности встроить его в технологическую 
цепочку. 

Параметры системы управления цветом программой Adobe Illustrator  
сохраняются в файле AI Color Settings, который размещается в папке C:\Windows\ 
Apptication Data\AdobeAdobe Illustrator. 

1.2. Проверка цветов в документе. 
После того как выполнена калибровка монитора и открыт нужный документ, 

цвета в документе могут выглядеть несколько иначе. В связи с этим требуется 
тщательная проверка цветов на предмет соответствия общему замыслу и изменение, 
если это необходимо, цветовых акцентов. 

В процессе работы над изображением можно использовать как, стандартные 
триадные цвета (process colors), так и плашечные цвета (spot colors), а также их 
произвольное сочетание. В процессе цветоделения все плашечные цвета могут быть 
конвертированы в триадные. Однако при необходимости плашечные цвета могут 
быть выведены отдельно для дополнительных печатных прогонов.  
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Кроме того, следует обратить внимание на некоторые приемы оформления, в 
частности на градиентные растяжки, которые эффектно могут отображаться на 
экране монитора, а в результате печати превратиться, например, в не радующую 
глаз совокупность цветных полос. 

2. Цветоделение векторных изображений. 
2.1. Способы цветоделения. 
Когда цветное изображение выводится на цветной принтер, то скрыто и 

усеченно происходят те же процессы, которые характерны для полиграфической 
печати (цветоделение и растрирование), автоматическое выполнение которых 
обеспечивается параметрами и установками принтера. При подготовке изображения 
для полиграфического исполнения этими процессами необходимо управлять 
целенаправленно, сообразуясь с поставленной задачей и с требованиями 
совершенно конкретного полиграфического предприятия (сервис-бюро и 
типографии). 

В общем случае цветоделение представляет собой разделение цветного 
изображения таким образом, чтобы оно снова было получено в результате печати 
несколькими одноцветными формами. 

Для репродуцирования цветных изображений типографским способом их 
подвергают разделению на несколько изображений таким образом, что, будучи 
напечатанными с точным совмещением (приводкой) определенными цветами, они 
воспроизводят оригинальное цветное изображение. Процесс разделения 
изображения называется цветоделением (color separation) и является неотъемлемым 
этапом допечатной подготовки изданий. 

 Цветоделение может выполняться двумя основными способами.  
1) Полноцветные изображения (сканированные фотографии, живописные 

произведения и прочие реалистические изображения) разделяются на отдельные 
изображения, печать которых осуществляется стандартными полиграфическими 
(триадными) красками: голубой (Cyan), пурпурной (Magenta), желтой (Yellow) и 
черной (Black). 

 2) Изображения, использующие плашечные цвета с ясно выраженными 
локальными цветами (логотипы, шрифт, декоративные элементы), делятся на 
отдельные изображения для каждого плашечного цвета. Их печать осуществляется 
смесевыми красками в соответствии с той или иной библиотекой, например 
PANTONE. У плашечных цветов гораздо шире цветовой охват, поскольку краска 
для печати готовится заранее и в нее могут быть внесены любые добавки, 
придающие ей необычный оттенок (например, "позолоченный", "неоновый", 
"флюоресцентный" и др.). Слой с плашечным цветом может использоваться для 
создания форм тиснения или нанесения лакового слоя. 

3) Если документ содержит полноцветные изображения и объекты с 
плашечными цветами, цветоделение может быть выполнено на полиграфическую 
триаду с конвертированием плашечных цветов, но может иметь место и сочетание 
этих двух способов: кроме четырех полос для полиграфических красок могут быть 
выведены и отдельные полосы для каждого плашечного цвета, в том числе для 
дополнительной печати флюоресцентными, металлизированными красками или 
лаковым покрытием. 

Обеспечение цветоделения заключается в подготовке аппаратной части (в 
частности, калибровка монитора), подготовке документа (например, создание 
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треппинга, определение цветовой палитры), установке параметров цветоделения с 
учетом требований печатного процесса. 

2.2. Подготовка к печати смесевыми красками. 
Напомним, что смесевые краски не состоят из основных (CMYK) красителей. 

Печать такими красками используется в двух случаях. 
Во-первых, часто возникают ситуации, когда цветов в документе всего два. 

Например, черный и красный или зеленый и оранжевый. Можно, конечно, 
напечатать такую работу и в четыре краски, но это будет стоить дополнительных 
денег, особенно если печатный станок имеет всего две печатные секции. 

Во-вторых, некоторые цвета в принципе невозможно передать с помощью 
CMYK. Скажем, металлизированные «золотые» и «серебряные» или насыщенный 
красный, ярко-зеленый и т. д. 

Словом, велика вероятность того, что придется думать о том, как подготовить 
к печати документ, который будет печататься несколькими (обычно двумя) 
смесевыми красками. 

Самый простой способ — заменить в документе одну смесевую краску 
голубой (С), а вторую — пурпурной (М). Но лучше создать свои или использовать 
готовые смесевые цвета, а потом спокойно ими пользоваться. 

Для создания нового цвета следует выберать в меню палитры Swatches 
(Образцы) пункт New Swatch (Новый образец). Появится окно параметров нового 
образца цвета. 

 

 
Рис. 8.1. Окно свойств образца цвета. 

 
В поле Swatch Name (Название образца) следует указать имя цвета, в списке 

Color Type (Тип цвета) выберите Spot Color (Смесевой цвет), после чего с помощью 
бегунков настроить цвет так, чтобы он был максимально похож на реально 
используемую краску и щелкнуть на кнопке ОК. Созданным цветом можно окрасить 
любой объект. Существует возможность использовать его оттенок. 

Если выделить объект, окрашенный данным смесевым цветом, палитра Color 
(Цвет) будет выглядеть так, как показано на рис. 8.2. 
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Рис. 8.2. Палитра Color при выделении объекта, окрашенного смесевым цветом. 

 
Задать оттенок можно в пределах от 0 до 100% с помощью бегунка  или на 

цветовой полосе в нижней части палитры. 
Во многих случаях удобно использовать готовые библиотеки смесевых 

цветов, тем более что многие из них соответствуют реальным красочным шкалам, 
используемым в полиграфии. Речь идет, прежде всего, о PANTONE. 

Для этого следует обратиться в меню Window > Swatches Libraries (Окно > 
Библиотеки образцов) и найти нужный цвет в списке PANTONE process coated.  
Появляется палитра библиотеки. 

 

 
Рис. 8.3. Палитра библиотеки цветов PANTONE process coated. 

 
Чтобы найти нужный цвет, достаточно ввести в строке Find (Найти) номер 

цвета, и искомый образец немедленно будет выделен в палитре библиотеки. 
Перетащив его на палитру Swatches (Образцы), цвет можно использовать. 

2.3. Параметры цветоделения. 
Перед тем как отправлять документ на распечатку цветоделенных полос, 

необходимо установить параметры цветоделения (линиатуру растра, позитив или 
негатив, печать под обрез и т. д.). 

Параметры цветоделения сохраняются в файле документа, а при открытии 
документа, у которого не сохранены такие параметры, программа восстанавливает 
параметры по умолчанию. 

Диалоговое окно установки параметров цветоделения можно вызвать 
непосредственно .командой Separation Setup (Параметры цветоделения) меню File 
(Файл) или в диалоговом окне Print (Печатать) кнопкой Separation Setup 
(Параметры цветоделения). 

Следует обратить внимание, что эти команды доступны только при активном 
PostScript-принтере. 

Для того чтобы определить внешнее устройство, на котором будут получены 
цветоделенные полосы, необходимо подключить файл PPD (PostScript Printer 
Description — файл с описанием параметров конкретного PostScript-принтера или 
фотонаборного автомата). В таких файлах (с расширением ppd) хранится 
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информация о выводном устройстве, включая его разрешение, форматы страниц, 
возможные линиатуры и т. д. 

В левой части диалогового окна Separations on (Цветоделение) находится окно 
просмотра, в котором отображаются документ и служебные элементы: шкалы, 
метки приводки и метки обреза. 

В окне просмотра предусмотрена возможность изменения размера 
габаритного прямоугольника, а также перемещения всей совокупности объектов. 

Группа Margins (Поля) служит для определения общего изобразительного 
поля, условно отображаемого в окне просмотра с помощью прямоугольника, у 
которого в углах и на сторонах имеются маркеры. Этот прямоугольник совпадает с 
метками обреза. 

Значения в полях Left (Слева), Right (Справа), Тор (Сверху) и Bottom (Снизу) 
обеспечивают расположение изображения в пределах страницы, а именно 
расстояния от границ страницы до изображения. Точка начала координат по 
умолчанию устанавливается в нижнем левом углу страницы. 

Поля изображения можно изменять и интерактивно, перемещая маркеры 
прямоугольника в окне просмотра. При размещении курсора в пределах габаритного 
прямоугольника обеспечивается перемещение объектов. 

Следует иметь в виду, что это перемещение не влияет на документ, но 
скажется при печати цветоделенных полос. 

В списке Separate (Выводить на цветоделение) группы Options (Параметры) 
можно выбрать вариант, который определит, какие слои выводить на цветоделение: 

1) Printable, Visible Layers (Печатные, видимые слои);  
2) Visible Layers (Видимые слои);  
3) All Layers (Все слои). 
По умолчанию программа Adobe Illustrator генерирует цветоделенные полосы 

для всех цветов, которые предполагает данный документ, в списке цветоделенных 
полос пиктограмма принтера означает, для какого цвета будут выводиться на 
принтер цветоделенные полосы. Если требуется вывод только определенных 
цветоделенных полос, то щелчком на пиктограмме печать ненужных полос можно 
отключить. 

Обычно цветоделение выполняется на четыре полиграфические краски, но 
если в документе имеются плашечные цвета, они могут быть конвертированы в 
модель CMYK или выведены отдельными отпечатками. Для определения этой 
альтернативы используется флажок Convert to Process (Все триадными), установка 
которого обеспечивает конвертирование шишечного цвета в триадный, о чем 
свидетельствует замена пиктограммы принтера на квадратик с четырьмя цветами 
(пиктограмма триадных красок). 

Для того чтобы конвертировать отдельный плашечный цвет в триадные цвета, 
необходимо снять флажок Convert to Process (Все триадными) и щелкнуть на 
пиктограмме принтера в строке конкретного плашечного цвета. Место пиктограммы 
принтера занимает пиктограмма триадных красок.  

 
3.  ОБОРУДОВАНИЕ И МАТЕРИАЛЬНО-ТЕХНИЧЕСКОЕ ОБЕСПЕЧЕНИЕ 

Компьютерные классы, оборудованные ПК с установленным программным 
обеспечением не ниже: 

1) Операционная система  Windows XP; 
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2) Менеджер файлов Total Commander 6.03 a; 
3) Векторный графический редактор Adobe Illustrator CS. 

 
4. ЗАДАНИЕ НА ЛАБОРАТОРНУЮ РАБОТУ 

Задание на лабораторную работу выдается в электронном виде. В качестве 
задания к лабораторной работе в папке «ТОИИ_Лр№08_задание» дан набор 
полноцветных штриховых изображений в формате ai. Имя файла соответствует 
номеру варианта. Заданием на лабораторную работу является цветоделение 
изображения с параметрами, соответствующими варианту задания, с сохранением 
профиля цветоделения.  

Варианты заданий для выполнения лабораторной работы 
Номер 

варианта 
Фирменный цвет 

1 PANTONE DS 98-1 U 
2 PANTONE DS 64-1 U 
3 PANTONE DS 197-1 U 
4 PANTONE DS 60-1 U 
5 PANTONE DS 259-1 U 
6 PANTONE DS 186-3 U 
7 PANTONE DS 60-1 U 
8 PANTONE DS 22-1 U 
9 PANTONE DS 188-1 U 
10 PANTONE DS 237-2 U 
11 PANTONE DS 14-2 U 
12 PANTONE DS 214-1 U 

 
 

5. ПОРЯДОК ВЫПОЛНЕНИЯ РАБОТЫ 
1) Сохранить оригинал на жестком диске, и открыть его с помощью 

программы Adobe Illustrator.  
2) Произвести визуальный анализ изображения и оценить какие элементы 

следует печатать плашечной краской (как правило фирменным цветом печатается 
логограмма или фон на котором она расположена, но не исключены случаи 
присутствия других элементов того же цвета). 

3) Согласно варианту задания  импортировать образец плашечной краски в 
набор цветов с помощью палитры Swatches (Образцы). 

4) Присвоить данный фирменный цвет ключевым элементам. 
5) Масштабировать изображение для вывода на формате А3. 
6) В диалоговом окне Print (Печатать) кнопкой Separation Setup (Параметры 

цветоделения) произвести настройки цветоделения с учетом того, что полноцветное 
изображение печатается всеми триадными красками и одной плашечной 
(фирменный цвет. В случае, если цветов в изображении меньше 4 или 4 – 
целесообразно печатать изображение только плашечными красками. 

7) Сохранить документ, как как «Лр№08_le.ai». 
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6. СОДЕРЖАНИЕ ОТЧЕТА 
Отчет о лабораторной работе сдается в электронном виде и должен содержать 

исходное и цветоделенное изображение в формате ai. 
 

7. КОНТРОЛЬНЫЕ ВОПРОСЫ 
1) Для чего используются дополнительные плашечные краски? 
2) Каким образом производятся настройки цветоделения? 
3) Каким образом при наличии фирменного цвета можно обойтись 

использованием триадных красок? 
 

8. БИБЛИОГРАФИЧЕСКИЙ СПИСОК 
1) Стефанов, С. Изображения: градация и цвет / С.Стефанов .— М. : 

Репроцентр М, 2005 .— 48с. 
2) Стефанов, С. Полиграфическое воспроизведение цветных изображений / 

С.Стефанов .— М. : Репроцентр-М, 2003 .— 32с. 
3) Стефанов, С. Цветное изображение на оригинале, мониторе компьютера и 

на полиграфическом оттиске / С.Стефанов;под ред.Ю.Стефановой .— М. : 
Репроцентр-М, 2003 .— 64с. 
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 Лабораторная работа № 9 (3 часа) 
ЯЗЫК POSTSCRIPT. 

 
1. ЦЕЛЬ И ЗАДАЧИ РАБОТЫ 

Цель работы: ознакомление с концепцией и основными операторами языка 
PostScript. 

Задачи работы: путем изучения текста  PostScript файла определить основные 
параметры изображения и извлечь  основную информацию о документе.  

 
2. ОСНОВНЫЕ ТЕОРЕТИЧЕСКИЕ СВЕДЕНИЯ 

1. Концепция языка PostScript. 
PostScript (Постскрипт) - язык описания страниц, в основном используемый в 

настольных издательских системах. 
Postscript был разработан Джоном Уорноком и Чаком Гешке из Adobe Systems 

в начале 80-х гг. Исходно Postscript использовался как ядро механизма печати 
компьютеров Apple, но вскоре стал широко распространенным стандартом для 
большинства компьютерных систем. Интерпретаторы Postscript (в виде 
программных или аппаратных компонентов) для печати документов присутствуют 
практически во всех современных компьютерных системах. В Postscript 
используется модель изображения текста (или рисунков) на чистой странице. Когда 
страница готова, она выводится на печать и начинается «пpорисовка» изображения 
очередной страницы. Это есть не что иное, как метод компиляции. Каждый 
документ Postscript включает в себя программу, которая печатает на принтере (или 
отображает на экране монитора) следующие друг за другом страницы. 

PostScript соединил в себе лучшие возможности принтеров и плоттеров. 
Подобно плоттерам, PostScript предоставляет возможность вывода 
высококачественной векторной графики и единый язык управления, который может 
быть использован любым производителем принтеров. Подобно матричным 
принтерам, PostScript предлагает удобные возможности по печати растровой 
графики и текста. В отличие от тех и других, PostScript может совмещать все эти 
типы вывода на одной странице, давая намного больше гибкости, чем до этого имел 
любой принтер или плоттер. 

PostScript - больше, чем типичный язык управления принтером, он является 
полнофункциональным языком программирования. Многие прикладные программы 
могут преобразовать документ в PostScript-программу, при выполнении которой 
будет получен начальный документ. Эта программа может быть послана 
непосредственно на принтер с поддержкой PostScript или преобразована 
интерпретатором PostScript в другой формат (для принтеров без поддержки 
PostScript), или результат её выполнения интепретатором может быть показан на 
экране. Так как исходная PostScript-программа одна и та же, PostScript называется 
независимым от устройства. 

Большинство высокопроизводительных принтеров и плоттеров имеют 
встроенный интерпретатор языка PostScript. В то же время, простые принтеры 
домашнего класса поддерживают только элементарные графические операции, 
поэтому задача создания растрового изображения возлагается на центральный 
процессор. Существуют интерпретаторы языка PostScript для различных 
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операционных систем, наиболее известный из них — свободная программа 
Ghostscript. 

Постскрипт - полнофункциональный язык программирования. Хотя 
программы на Постскрипте и создаются в основном не людьми, а другими 
программами, в принципе ничто не мешает писать на нём программы для обсчёта 
графики, реализации численных методов решения математических задач и т. п. 

Постскрипт - интерпретируемый стековый язык, похожий на Форт. Синтаксис 
языка использует обратную польскую нотацию, что делает ненужным 
использование скобок, однако требует некоторой практики для чтения текста 
программы из-за необходимости держать в голове содержимое стека. Большинство 
операторов берут операнды со стека и помещают результат вычислений на стек. 
Литералы (строки и числа) помещают свою копию на стек. 

PostScript имеет черты метафайла, совмещая поддержку как векторных, так и 
растровых изображений. Шрифты в PostScript только векторные. Положение 
элементов на странице задаётся в типографских пунктах. 

2. Структура документа 
Структура файла PostScript формируется структурными комментариями. 

Структурные комментарии начинаются с последовательности символов «%%» в 
начале строки. Файл PostScript состоит из четырёх частей: заголовка, пролога, тела и 
эпилога. Заголовок начинается строкой %!PS-Adobe-N.M где N.M - версия 
спецификации, далее идут структурные комментарии с общими свойствами 
документа, и заканчивается заголовок строкой %%EndComments. 
%!PS-Adobe-2.0 
%%Creator: dvips(k) 5.78 Copyright 1998 Radical Eye Software 
%%Title: rep.dvi 
%%Pages: 9 
%%PageOrder: Ascend 
%%BoundingBox: 0 0 596 842 
%%EndComments 

В прологе обычно содержатся описания подпрограмм и данные, необходимые 
для печати документа - например, процедуры и шрифты. Пролог заканчивается 
комментарием %%EndProlog. 

В теле программы содержатся команды, отвечающие за отрисовку каждой 
страницы, предваряемые строкой %%Page: <метка> <номер>, где <метка> — 
метка страницы, которая не выводится на печать, и <номер> — порядковый номер 
страницы в файле, например, %%Page: iii 3 

После команд отрисовки всех страниц идёт структурный комментарий 
%%Trailer, после чего начинается эпилог. 

В эпилоге можно продублировать комментарии из заголовка (это реализовано 
на случай, если в начале вывода программе ещё не известно, например, число 
страниц) - в этом случае вместо числовых значений параметров в заголовке надо 
писать (atend). 

Заканчивается файл строкой %%EOF. 
3. Пример программы 

%!PS-Adobe-1.0 
% По умолчанию, постскрипт использует единицу измерения 1 пункт=1/72 дюйма,  
% а нужны  миллиметры. 
72 25.4 div                       % 1 мм = 72/25.4 пунктов 
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dup                                   % дублировать значение на вершине стека 
scale                                  % растянуть в это количество раз по обеим координатам 
100 100 translate              % установить начало координат в (100мм, 100мм) 
/Times-Roman findfont    % взять шрифт Times-Roman 
10 scalefont                       % растянуть до размера 10 (у нас единица измерения - мм!) 
setfont                               % установить выбранный шрифт 
0 30 330 {                         % цикл для углов от 0 до 330 с шагом 30 
gsave                                 % запомнить текущее преобразование координат 
rotate                                % повернуть систему координат  
15 0 moveto                     % перейти в точку (15мм, 0мм) 
(Wikipedia) sh                 % написать слово текущим шрифтом 
grestore                            % вернуть преобразование координат 
} for                                 % конец цикла for 
showpage                        % вывести страницу 

3. Рисование. 
Рассмотрим вначале геометрическую структуру страницы, на которой мы 

рисуем. Координаты точек на странице PostScript выражает в пиксельных единицах, 
равных одной семьдесят второй дюйма. Левый нижний угол прямоугольной 
страницы соответствует координатам (0,0), горизонтальный и вертикальный 
размеры страницы равны 612 и 792, соответственно. Эти размеры соответствуют 
формату бумаги letter. Можно определить размеры бумаги другими:  
note: 540 на 720, 

 или 
legal: 612 на 1008,  

или 
a4: 595 на 842. 

Это - обычные команды. Команда a4 сменит размер листа на A4, например.  
Определения размера страницы находятся в файле инициализации по имени 

gs_statd.ps. Он находится в каталоге /usr/lib/ghostscript (для Slackware). Можно 
определить любые нестандартные размеры бумаги добавлениями и исправлениями 
этого файла.  

Следующий шаг после выбора размера бумаги - поместить курсор в начало 
рисунка. Это делается при помощи команды  

x y moveto 
Где x и y обозначают горизонтальную и вертикальную координаты курсора, 

соответственно. x и y являются числами и выражаются в пиксельных единицах, 
moveto - команда, помещающая курсор в точку с координатами (x,y).  

Поскольку PostScript использует стек, параметры вначале последовательно 
кладутся на стек. Затем дается команда. Она снимает со стека предыдущие два 
элемента в качестве своих параметров. Синтаксис здесь отличается от того, к 
которому привыкли те, кто знаком с языками типа C. Каждая команда, требующая 
параметров, задается после ее параметров.  

Перейдем к рисованию фигур. Чтобы нарисовать отрезок нужно выполнить 
следующую команду:  
xx yy lineto  

где xx и yy отмечают положение конца отрезка. Его начало - текущее 
положение курсора, x и y. Эта команда конструирует отрезок от точки (x,y) до точки 
(xx,yy). Чтобы он действительно оказался нарисован, нужно выполнить еще 
команды определения контура newpath и stroke.  
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Приведеи пример PostScript программы для рисования прямоугольника. Это 
можно сделать, используя уже описанные приемы.  
newpath 
100 100 moveto 
300 100 lineto 
300 250 lineto 
100 250 lineto 
100 100 lineto stroke 

Хотя в примерах каждая команда на отдельной строчке, это на самом деле не 
обязательно. Вполне допустимо набирать их на одной строчке, вставляя между 
командами пробелы. 

 PostScript, как и другие языки программирования, имеет средства для вставки 
комментариев. Все, что следует в строке за символом процента, рассматривается 
интерпретатором как комментарий.  
newpath 
% Инициализация курсора  
100 100 moveto 
% Рисование прямоугольника  
300 100 lineto 
300 250 lineto 
100 250 lineto 
100 100 lineto stroke 

Команда stroke указывает интерпретатору нарисовать фигуру.  
Есть еще две команды, удобные при конструировании отрезков: rmoveto и 

rlineto. Они принимают по два параметра и используются так:  
 
x y rmoveto 
x y rlineto 

где x и y задают горизонтальное и вертикальное расстояние между начальной 
и конечной точкой каждой операции. 'r' в rmoveto и rlineto означает relative 
(относительный). Иными словами, первая команда перемещает курсор на x единиц 
вправо и на y единиц вверх от его текущего положения. Вторая команда работает 
аналогично, только еще и рисует отрезок, а не только перемещает курсор.  

Все перечисленные команды используют при рисовании значение толщины 
линии, равное по умолчанию одному пикселу. Однако, пользователь может менять 
толщину в любом месте программы. Это делается командой  
x setlinewidth 

где x задает толщину линии в пикселях. Действие этой команды продолжается 
до следующего изменения толщины линии.  

Разумеется, рисование на PostScript не ограничено проведением отрезков. 
Можно рисовать дуги окружности. Для этого есть команда  
x y r a b arc 

где x, y, r, a и b задают горизонтальную и вертикальную координаты центра 
дуги, радиус дуги и углы между положительным направлением горизонтальной оси 
и лучами из центра в начало и конец дуги, соответственно. Углы измеряются против 
часовой стрелки. Если начальная точка дуги не совпадает с положением курсора, то 
от курсора до нее рисуется отрезок.  
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Контур начинается оператором newpath. Он инициализирует текущий контур. 
Затем он конструируется выполнением команд, добавляющих сегменты к текущему 
контуру.  

Команду arc можно использовать для рисования полной окружности. Для 
этого достаточно начальный и конечный углы дуги задать как 0 и 360, 
соответственно. arc можно также заставить рисовать эллипсы. Для этого нужно 
вспомнить о масштабирующих свойствах PostScript. Пользователь может раздельно 
менять масштаб по горизонтальной и вертикальной осям командой  
x y scale 

где x и y задают, соответственно, коэффициенты масштабирования по 
горизонтали и вертикали.  

В PostScript есть также команда рисования кривых Безье, которые можно 
использовать для интерполяции или экстраполяции набора данных. Это - команда 
curveto, которая используется так:  
x1 y1 x2 y2 x3 y3 curveto 

где кривая начинается в текущей точке, координаты которой принимаются за 
(x0, y0). Кривая в начальной точке является касательной к отрезку между (x0, y0) и 
(x1, y1). Заканчивается она в точке (x3, y3) и касается отрезка от (x2, y2) до (x3, y3). 
По умолчанию считается, что все четыре точки различны и определяют форму 
фигуры. 

4. Текст 
PostScript имеет различные шрифты, стандартно используемые для DTP. Есть 

также средства создания шрифтов, доступные путем определения словарей на стеке, 
где хранятся шрифты. Рассмотрим следующую программу.  
/Times-Roman findfont 
15 scalefont 
setfont 
100 500 moveto 
(I love PostScript!) show 
/Times-Italic findfont 
20 scalefont 
setfont 
100 450 moveto 
(I love PostScript!) show 
/Times-Bold findfont 
25 scalefont 
setfont 
100 400 moveto 
(I love PostScript!) show 
/Helvetica findfont 
30 scalefont 
setfont 
100 350 moveto 
(I love PostScript!) show 
/Courier findfont 
35 scalefont 
setfont 
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100 300 moveto 
(I love PostScript!) show 
/Helvetica-Bold findfont 
40 scalefont 
setfont 
100 250 moveto 
(I love PostScript!) show 
showpage 

Как можно понять из программы, команда findfont используется для 
получения доступа к структуре желаемого шрифта. Имя шрифта начинается с 
символа '/', и задается в качестве параметра команды ('/' указывает интерпретатору 
положить его значение на стек "как есть"). Позже мы вернемся к подробностям 
стековых операций, и это станет более ясным. После выбора шрифта он 
масштабируется командой scalefont. Коэффициент масштабирования ставится перед 
этой командой. После масштабирования шрифта, команда setfont делает шрифт 
готовым к использованию в программе. После помещения курсора командой moveto 
с соответствующими параметрами, команде show дается текст для вывода в виде 
параметра, заключенного в круглые скобки. Команда showpage завершает вывод 
написанного. Приведенная программа использует шрифты разного типа и размера 
для вывода одного и того же текста в разных местах страницы. Буквы можно 
располагать вдоль прямых или кривых, так что, в принципе, возможно создавать 
сколь угодно сложный набор.  

5. Цвет 
Язык PostScript включает несколько способов раскраски фигур или создания 

цветных картинок. Начнем с упоминания о командах смены цвета. PostScript по 
умолчанию использует черный цвет. Поэтому вывод всех предыдущих программ 
был черно-белым. Для включения цвета в PostScript можно пользоваться тремя 
разными командами. Первая базируется на формате цвета RGB. В этом формате 
каждый цвет составляется из трех основных цветов: красного, зеленого и синего. 
Компоненты цвета задаются отдельными значениями интенсивности, 
принимающими значения между 0 и 256. Значение интенсивности может быть 
дробным числом, имеющим до трех знаков после запятой, например, 111.223. Таким 
образом, команда выглядит так:  
x y z setrgbcolor 

где x,y и z являются значениями интенсивности для красной, зеленой и синей 
компонент, а setrgbcolor - команда.  

Второе средство установки цвета базируется на четырехкомпонентном 
формате цвета. Он называется форматом CMYK. Четыре базовых цвета - голубой, 
пурпурный, желтый и черный. Каждая цветовая компонента влияет на цвет в 
соответствии с параметром интенсивности, изменяющимся от 0 до 1. Таким 
образом, соответствующая команда выглядит так:  
w x y z setcmykcolor 

где w, x, y, z --- значения интенсивности голубой, пурпурной, желтой и черной 
компонент, соответственно. Эта команда также продолжает действовать до 
следующей смены цвета, после чего действуют следующие установки. Нет никаких 
ограничений на число вызовов этой команды в PostScript программе.  

Третья команда выглядит так:  
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x y z sethsbcolor 
где x, y, z означают интенсивность трех свойств цвета. Первый соответствует 

оттенку, определяющему положение цвета в спектре. Второй соответствует 
насыщенности, а третий - яркости цвета. Читатель, не знакомый с пространством 
цветов HSB (hue-saturation-brightness, цвет-насыщенность-яркость), может 
попробовать поработать с программой xfig.  

PostScript может также использовать оттенки серого. Это делается командой  
x setgray  

где x задает интенсивность серого, чье значение может меняться от 0, 
соответствующего черному, до 1, соответствующего белому.  

 
3.  ОБОРУДОВАНИЕ И МАТЕРИАЛЬНО-ТЕХНИЧЕСКОЕ ОБЕСПЕЧЕНИЕ 

Компьютерные классы, оборудованные ПК с установленным программным 
обеспечением не ниже: 

1) Операционная система  Windows XP; 
2) Менеджер файлов Total Commander 6.03 a; 
3) Интерпретатор RoPS PostScript Interpreter v5.1. 
 

4. ЗАДАНИЕ НА ЛАБОРАТОРНУЮ РАБОТУ 
Задание на лабораторную работу выдается в электронном виде. В качестве 

задания к лабораторной работе в папке «ТОИИ_Лр№10_задание» дан набор 
документов в формате Post script. Имя файла соответствует номеру варианта. 
Заданием на лабораторную работу является анализ файла и описание основных его 
параметров.  

 
5. ПОРЯДОК ВЫПОЛНЕНИЯ РАБОТЫ 

1) Ознакомиться с PostScript файлом, соответствующим номеру варианта и 
письменно дать ответить на следующие вопросы. 

2) В какой программе создан документ? 
3) Как называется документ? 
4) Сколько страниц в документе? 
5) Какие шрифты используются в документе? 
6) Размер документа? 
7) Какие краски используются? 
8) Используются ли плашечные краски, если да, то какие? 
9) Открыть исходный файл с помощью интерпретатора и сравнить ответы с 

фактическими параметрами. 
 

6. СОДЕРЖАНИЕ ОТЧЕТА 
Отчет о лабораторной работе сдается в электронном виде и должен содержать 
текстовый файл с описанием основных параметров изображения и 
интерпретированное изображение в формате pdf. 

 
7. КОНТРОЛЬНЫЕ ВОПРОСЫ 

1) Какова основная концепция языка PostScript? 
2) Какие элементы описывает язык PostScript? 
3) К каким изображенияем применим PostScript ? 
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Лабораторная работа № 10 (3 часа) 
АВТОМАТИЗАЦИЯ ПРОЦЕССОВ ОБРАБОТКИ ИЗОБРАЗИТЕЛЬНОЙ 

ИНФОРМАЦИИ. 
 

1. ЦЕЛЬ И ЗАДАЧИ РАБОТЫ 
Цель работы: ознакомление с методами  создания, редактирования и 

использования макрокоманд. 
Задачи работы: создать набор пользовательских макрокоманд для обработки 

изображений средствами Adobe Photoshop. 
 

2. ОСНОВНЫЕ ТЕОРЕТИЧЕСКИЕ СВЕДЕНИЯ 
1. Макрокоманды и их параметры. 
Действия  (Actions) - наборы максимально автоматизированной 

последовательности действий программы по обработке изображений - по сути дела 
являются макрокомандами. 

Создание макрокоманды  заключается в том, что во время выполнения той или 
иной последовательности команд программа Adobe Photoshop записывает их в том 
же порядке, включая и те параметры, которые применялись каждой конкретной 
командой. Таким образом, можно записать любую последовательность команд и в 
дальнейшем использовать ее, сокращая время и, главное, усилия на выполнение 
рутинных операций.  

2. Палитра Actions (Действия). 
Палитра Actions (Действия) используется для записи, выполнения и 

редактирования последовательности действий по обработке изображений. Для того 
чтобы вывести палитру на экран, необходимо выполнить команду Actions 
(Операции) меню Window (Окно).   

Палитра Actions (Операции) содержит набор команд в виде строк, которые 
раскрываются, если щелкнуть на треугольной стрелке, показывающей вправо. 
Каждая команда открывает список параметров команды, если таковые имеются.   

В левой колонке расположены поля, которые служат для включения или 
выключения отдельных команд, а рядом с ними поля для включения и отключения 
вывода диалоговых окон соответствующих команд.  

Пользователь имеет возможность видоизменить последовательность 
выполнения команд. Кроме того, команды одного макроса можно переместить в 
другие. Для того чтобы изменить порядок команд, необходимо в списке палитры 
захватить команду и переместить ее в новое положение. Жирная линия отображает 
положение строки команды во время перемещения.  

3. Содание и запись макрокоманд. 
В макросе могут использоваться действия инструментов Gradient (Градиент), 

Marquee (Область), Crop, Polygon Lasso Line (Линия), Move, Magic Wand 
(Волшебная палочка), Paint Bucket (Заливка) и Type (Текст), а также установки 
палитр Paths (Контуры), Channels (Каналы), Layers (Слои) и History (История).  

Однако существуют и ограничения: некоторые команды и функции могут 
включаться в макросы только с помощью процедуры записи выполняемых 
действий. Для включения в операцию команд, которые не могут быть определены во 
время записи, следует использовать команду Insert Menu Item (Вставить пункт 
меню).  
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Следует обратить внимание еще на одно очень существенное ограничение. 
Успех выполнения записанного макроса с другим документом и в другое время в 
значительной степени зависит от параметров другого документа (цветовой модели, 
разрешения, активного слоя и т. д.), а также от текущих установок программы 
(например, основного и фонового цветов и некоторых других). Поэтому макросы, 
создаваемые таким образом, в значительной степени могут иметь сугубо 
ситуативный характер. Но и это может сэкономить много времени, особенно если 
речь идет о большом объеме однотипной обработки изображений.  

Следует также иметь в виду, что при использовании в качестве элементов 
макросы команд Save As (Сохранить как) или Save a Copy (Сохранить копию) в 
диалоговых окнах этих команд не нужно вводить конкретные имена файлов.  

4. Создание макрокоманд методом записи. 
Для того чтобы создать макрокоманду методом записи, необходимо открыть 

редактируемый документ, вывести на экран палитру Actions (Операции), выбрать в 
ней набор макрокоманд и выполнить одно из двух действий: 

а) нажать на кнопку New Action (Новая операция); 
б) использовать команду New Action (Новая операция) меню палитры.  
В обоих случаях на экран будет выведено диалоговое окно New Action (Новая 

операция), в котором можно присвоить имя макрокоманде (поле Name (Имя)), 
определить набор макрокоманд (раскрывающийся список Set (Набор)) и 
комбинацию клавиш для ее запуска (поле Function Key (Функциональная клавиша)), 
а также выбрать один из семи цветов для отображения имени макроса в палитре 
(список Color (Цвет)). 

Затем нажать на кнопку Record (Запись), после чего пиктограмма на кнопке 
записи в палитре Actions (Операции) станет красного цвета.  

Теперь можно начинать выполнение команд, которые необходимо сохранить в 
макрокоманде. Если команда имеет диалоговое окно, то после установки нужных 
значений следует нажать на кнопку ОК. Если предполагается делать изменения 
настроек в процессе выполнения макросы, то можно оставить значения по 
умолчанию, но и в этом случае нажатие на кнопку ОК обязательно. При выходе из 
диалогового окна после нажатия на кнопку Cancel (Отменить) данная команда не 
записывается в макрокоманду. Остановка записи происходит при нажатии на кнопку 
Stop (Остановка) в нижней части палитры Actions (Операции).  

5. Вставка пунктов меню. 
Многие команды, которые не записываются во время исполнения (например, 

параметры рисующих инструментов, команды просмотра и некоторые другие), 
можно включить в список макросы с помощью команды Insert Menu Item (Вставить 
пункт меню)  палитры.  

Отличие такого включения от записи заключается в том, что в этом случае 
команда как таковая не выполняется (до начала работы макроса), а следовательно, 
никакие параметры команды не фиксируются, и само собой разумеется, никакого 
действия на текущий документ не оказывается. Это в чистом виде операция 
программирования. Во время выполнения макроса для такой команды открывается 
соответствующее диалоговое окно, в котором пользователю необходимо определить 
свои собственные параметры или принять параметры по умолчанию и нажать на 
кнопку ОК.  
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Для того чтобы вставить пункт меню в макрокоманду, необходимо определить 
место вставки в существующей макрокоманде: выделить имя макроса в списке 
палитры, выполнить команду Insert Menu Item (Вставить пункт меню), которая 
выведет на экран одноименное диалоговое окно, а затем открыть и выделить 
команду, после которой будет осуществлена вставка новой команды.  После 
нажатия на кнопку ОК в списке макросов появляется новая команда.  

6. Вставка остановок. 
 Во время выполнения макроса достаточно часто возникает необходимость 

прервать действие на какое-то время для того, чтобы осуществить действие, которое 
невозможно записать, например выделить фрагмент изображения или сделать штрих 
одним из рисующих инструментов. Продолжение работы макроса осуществляется 
нажатием на кнопку Play (Воспроизведение) в нижней части палитры. 

Чтобы не забыть о назначении паузы (остановки), лучше сделать 
соответствующий комментарий в поле Message (Сообщение).  

Для вставки остановки в список макросов необходимо выполнить следующие 
действия: определить место вставки остановки в существующей макрокоманде: 
выделить имя макроса в списке палитры, открыть и выделить команду, после 
которой будет вставка остановки; выполнить команду Insert Stop (Вставить 
остановку) меню палитры, которая выводит на экран диалоговое окно Record Stop 
(Записать остановку), параметры этой команды также отображаются в палитре 
Actions (Операции). 

В поле Message (Сообщение) можно ввести произвольный текст, который 
будет выводиться при остановке макроса. При включении флажка Allow Continue 
(Разрешить продолжение) в диалоговом окне сообщений выводится кнопка 
Continue (Продолжить).  

7. Выполнение макрокоманд. 
Выполнять последовательность действий макросов можно с любой команды и 

в произвольном сочетании (хотя и в одной последовательности).  
Кроме того, есть возможность выполнить только одну отдельную команду. 

При необходимости любую команду можно исключить из выполнения. Для 
исключения команды из выполнения необходимо щелкнуть на левой колонке, рядом 
с названием команды, удаление флажка означает исключение команды.  

Если команда предполагает наличие диалогового окна, оно может быть 
выведено для установки или изменения параметров. Если вывод диалогового окна 
отключен, программа будет использовать текущие установки диалогового окна (а 
само окно выводиться не будет). Для определения вывода на экран диалогового окна 
во время выполнения макросы необходимо щелкнуть в столбце рядом с именем 
команды. Если в этой клеточке отображается символическое изображение 
диалогового окна, то диалоговое окно будет выводиться, и наоборот.  

Запись макрокоманд можно дополнить их последующим редактированием, 
например можно изменить порядок команд, добавить новые команды, повторить 
команды, изменить параметры команд, а также удалить команды.  

Непосредственно на панели Actions (Операции) можно перенести любую 
макрокоманду в другой набор. Для этого необходимо захватить строку макроса и 
перетащить ее в нужный набор. Таким же образом можно изменить порядок команд 
в макрокоманде.  
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Для записи дополнительной команды надо выделить команду, после которой 
необходима вставка, а затем, нажав на кнопку Record (Запись) в нижней части 
палитры, выполнить нужную команду или последовательность команд. Щелчок на 
кнопке Stop (Остановка) прекратит запись.  

Предусмотренная в палитре Actions (Операции) возможность повторения 
команд и макрокоманд очень полезна для редактирования самих макрокоманд и 
создания на их базе новых макрокоманд.  

8. Применение макрокоманды к отдельному документу. 
Последовательность действий для применения макросов к отдельному 

документу (в противоположность пакетной обработке) может быть следующей:  
1) Открыть необходимый документ. Для того чтобы выполнить макрокоманду 

полностью, требуется выделить имя макроса, а если надо выполнить макрокоманду 
не с начала, следует открыть и выделить команду, с которой следует начинать 
выполнение. Чтобы запустить выполнение макроса, можно воспользоваться кнопкой 
Play (Воспроизведение) в нижней части палитры или командой Play 
(Воспроизведение) меню палитры.  

2) Двойной щелчок на имени макроса в палитре выводит на экран диалоговое 
окно Actions Options (Параметры операции), которое идентично диалоговому окну 
New Action (Новая операция). Если же двойной щелчок выполнить при нажатой 
клавише <Ctrl>, макрокоманда начинает выполнение от начала и до конца.  

Следует иметь в виду, что поскольку макрокоманда - это последовательность 
команд (хотя минимально она может состоять из одной команды), выполнить 
отмену действия всей макрокоманды с использованием команды undo (отменить) 
нельзя. Команда undo (отменить) позволяет вернуться только на один шаг назад.  

Вместе с тем отменить действие макроса можно, если использовать 
возможности палитры History (История).  

Повторение команды или макроса можно осуществить следующим образом: 
при нажатой кнопке можно захватить и перетащить нужную команду или 
макрокоманду в новое положение в списке палитры; можно выделить команду или 
макрокоманду и выполнить команду Duplicate (Повторить) меню палитры; можно 
перетащить имя команды или макроса на кнопку New Action (Новая операция) в 
нижней части палитры. Для выделения нескольких команд необходимо 
использовать клавишу <Shift>.  

Для изменения параметров команды достаточно дважды щелкнуть на строке 
команды и вызвать соответствующее диалоговое окно.  

В любой момент можно удалить макрокоманду целиком или произвольную 
отдельную команду, входящую в макрокоманду. Для этого в списке макрокоманд 
следует выделить нужную (точнее, ненужную) макрокоманду или команду и 
щелкнуть на кнопке Trash (Корзина) в нижней части палитры или выполнить 
команду Delete (Удалить) меню палитры. Как то, так и другое действие выведет на 
экран окно-запрос на удаление, и после некоторого раздумья можно будет нажать на 
кнопку ОК.  

9. Сохранение, загрузка и замена наборов макрокоманд. 
Поскольку нельзя бесконечно добавлять новые макросы, в программе 

предусмотрена возможность создания наборов (set) макрокоманд и сохранения их на 
диске в специальном файле с расширением .atn.  
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Это позволяет более рационально организовывать работу над различными 
проектами или разными типами изображений, а также передавать другим 
пользователям для обеспечения идентичной обработки изображений. Сохранять 
можно только наборы макрокоманд целиком, отдельные макросы или команды 
сохранять нельзя (если только они не составляют набор), новые макросы 
автоматически сохраняются в файле Actions Palette.psp (в папке Windows\Application 
Data\Adobe\Photoshop\CS2\Adobe Photoshop Settings ). При удалении этого файла (с 
целью восстановления исходных установок программы) будет удален и набор 
макрокоманд, поэтому вполне разумно заранее сохранить макросы в независимом 
файле.  

Для того чтобы создать новый набор макрокоманд, необходимо выполнить 
команду New Set (Новый набор) меню палитры или нажать на кнопку Create New Set 
(Создать новый набор), расположенную в нижней части панели Actions (Операции). 
В обоих случаях на экран выводится диалоговое окно, в котором требуется ввести 
имя набора или принять предлагаемое программой.  

Имя набора можно в любой момент изменить, вызвав это же диалоговое окно 
командой Set Options (Задать параметры). Для сохранения набора макрокоманд 
достаточно выделить необходимый набор и выполнить команду Save Actions 
(Сохранить операции) меню палитры. На экран будет выведено диалоговое окно 
Save (Сохранить), в котором можно присвоить имя набору макрокоманд (или 
оставить текущее) и определить папку для хранения.  

Для замены текущего набора макрокоманд на ранее сохраненный необходимо 
выполнить команду Replace Actions (Заменить операции) меню палитры. Для 
загрузки нового набора макрокоманд, который добавится в конец списка текущих 
макрокоманд, надо выполнить команду Load Actions (Загрузить операции) меню 
палитры. В обоих случаях на экран выводится диалоговое окно Load (Загрузить), в 
котором можно выбрать файл с расширением *.atn.  

 
3.  ОБОРУДОВАНИЕ И МАТЕРИАЛЬНО-ТЕХНИЧЕСКОЕ ОБЕСПЕЧЕНИЕ 

Компьютерные классы, оборудованные ПК с установленным программным 
обеспечением не ниже: 

1) Операционная система  Windows XP; 
2) Менеджер файлов Total Commander 6.03 a; 
3) Растровый графический редактор Adobe Photoshop CS. 

 
4. ЗАДАНИЕ НА ЛАБОРАТОРНУЮ РАБОТУ 

Заданием на лабораторную работу является создание Action пакетной 
обработки изображений с параметрами, соответствующими варианту задания.  
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Варианты заданий для выполнения лабораторной работы 
Номер 

варианта 
Действия 

1 1)Изменить разрешение изображения на x dpi с использованием 
мягкой бикубической интерполяции. 
2)Увеличить содержание красного в светах на 40, в средних тонах на 
25. 
3)Установить максимальную яркость в изображении равной 220. 
4)Применить к изображению фильтр Dry Brush  с величиной кисти x  
с максимальной детализацией и минимальным текстурированием. 
5)Вырезать часть изображения в виде текста «GO!» c гарнитурой 
Courier  высотой 50 мм и поместить его на прозрачный фон. 

2 1)Уменьшить изображение до 1000 px по горизонтали с 
использованием  бикубической интерполяции. 
2)Увеличить содержание голубого  в тенях  на 45, в средних тонах на 
15. 
3)Установить максимальную яркость в изображении равной x. 
4)Применить к изображению фильтр Dry Brush  с максимальной 
детализацией и минимальным текстурированием и размером кисти. 
5)Создать по краю изображения рамку с прямыми углами цветом # 
00a4e8 и толщиной x px. 

3 1)Увеличить изображение до 1000 px по вертикали с использованием  
билинейной интерполяции. 
2)Увеличить содержание розового  в тенях  на 55, в средних тонах на 
x. 
3)Установить минимальную яркость в изображении равной 20. 
4)Применить к изображению фильтр Cutout  числом уровней x  и 
максимальной  точностью и сложностью грани. 
5)Вырезать часть изображения в виде текста «FIRST» c гарнитурой 
Comic Sans  размером  150 пунктов и поместить его на прозрачный 
фон. 

4 1)Уменьшить изображение в 2 раза с использованием мягкой 
бикубической интерполяции. 
2)Увеличить содержание желтого в светах на 20, в средних тонах на 
45. 
3)Установить минимальную яркость в изображении равной x. 
4)Применить к изображению фильтр Cutout  с максимальной  
точностью, сложностью грани и числом уровней. 
5)Вырезать часть изображения в виде текста «START» c гарнитурой 
Arial высотой 200 px и поместить его на прозрачный фон. 

5 1)Увеличить изображение в 2 раза с использованием  бикубической 
интерполяции. 
2)Увеличить содержание зеленого в светах на x, в средних тонах на 
45. 
3)Установить максимальную яркость в изображении равной 230. 
4)Применить к изображению фильтр Accented Edges с толщиной 
обводки  x  с яркостью грани 35 и мягкостью 3. 
5)Вырезать часть изображения в виде текста «STOP»  c гарнитурой 
Arial высотой 200 px и поместить его на прозрачный фон. 
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6 1)Увеличить изображение на 25% с использованием  билинейной 
интерполяции. 
2)Увеличить содержание голубого  в тенях  на 25, в средних тонах на 
35. 
3)Установить максимальную яркость в изображении равной x. 
4)Применить к изображению фильтр Accented Edges с минимальной 
толщиной обводки   с яркостью грани 35 и мягкостью 3. 
5)Создать по краю изображения рамку с закругленными  углами 
цветом # 00a4e8 и толщиной x px. 

7 1)Уменьшить изображение на 25% с использованием мягкой 
бикубической интерполяции. 
2)Увеличить содержание бирюзового в светах на 10, в средних тонах 
на 40. 
3)Установить минимальную яркость в изображении равной x. 
4)Применить к изображению фильтр Ink Outlines  c минимальной 
длиной штриха и равной интенсивностью светов и теней. 
5)Вырезать часть изображения в виде текста «NEXT» c гарнитурой 
Comic Sans  размером  150 пунктов и поместить его на прозрачный 
фон. 

8 1)Изменить разрешение изображения на x dpi с использованием  
бикубической интерполяции. 
2)Увеличить содержание розового  в тенях  на 45, в средних тонах на 
15. 
3)Установить минимальную яркость в изображении равной 15. 
4)Применить к изображению фильтр Ink Outlines  c длиной штриха x  
и равной интенсивностью светов и теней. 
5)Создать по краю изображения рамку с закругленными  углами 
цветом x и толщиной 15 px. 

9 1)Увеличить изображение в x раз с использованием мягкой 
бикубической интерполяции. 
2)Увеличить содержание зеленого в светах на 15, в средних тонах на 
35. 
3)Установить максимальную яркость в изображении равной 250. 
4)Применить к изображению фильтр Water Paper  c длиной 
текстурного штриха 3, яркостью x  и контрастом 80. 
5)Создать по краю изображения рамку с закругленными  углами 
цветом #c30080 и толщиной 10 px. 

10 1)Увеличить изображение в 2,5 раза с использованием  бикубической 
интерполяции. 
2)Увеличить содержание бирюзового в светах на 15, в средних тонах 
на 35. 
3)Установить максимальную яркость в изображении равной x. 
4)Применить к изображению фильтр Water Paper  c длиной 
текстурного штриха 3, яркостью 67  и контрастом 80. 
5)Создать по краю изображения рамку с прямыми углами цветом x и 
толщиной 15 px. 
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11 1)Увеличить изображение на 30% с использованием  билинейной 
интерполяции. 
2)Увеличить содержание красного в светах на 25, в средних тонах на  
x. 
3)Установить минимальную яркость в изображении равной 10. 
4)Применить к изображению фильтр Grain  с интенсивностью 17и 
контрастом x. 
5)Создать по краю изображения рамку с прямыми углами цветом 
#c30080 и толщиной 10 px. 

12 1)Увеличить ширину изображения в x раз с использованием мягкой 
бикубической интерполяции. 
2)Увеличить содержание желтого в светах на 40, в средних тонах на 
25. 
3)Установить максимальную яркость в изображении равной 245. 
4)Применить к изображению фильтр Grain  с интенсивностью 45 и 
контрастом x. 
5)Вырезать часть изображения в виде текста «OUT» c гарнитурой 
Courier высотой 50 мм и поместить его на прозрачный фон. 

 
 

5. ПОРЯДОК ВЫПОЛНЕНИЯ РАБОТЫ 
1) С помощью палитры Actions (Операции) создать макрокоманду, которая 

позволяет после открытия файла изображения выполнить автоматизировано 
действия, перечисленные в варианте задания. 

2) Сохранить набор с макрокомандой как «Лр№10_le.atn». 
 

6. СОДЕРЖАНИЕ ОТЧЕТА 
Отчет о лабораторной работе сдается в электронном виде и должен содержать 

набор с макрокомандой  в формате atn. 
 

7. КОНТРОЛЬНЫЕ ВОПРОСЫ 
1) В каких ситуациях используются макрокоманды? 
2) Почему нельзя добавлять в наборы макрокоманд такие действия, как мазок 

кистью или восстановление текстуры лечащей кистью? 
3) Для чего предусмотрена возможность вывода диалоговых окон при 

выполнении макрокоманды? 
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